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The National Anthem of Sri Lanka

Sri Lanka Matha
Apa Sri Lanka Namo Namo Namo Namo Matha
Sundara siri barinee, surendi athi sobamana Lanka
Dhanya dhanaya neka mal palaturu piri jaya bhoomiya ramya 
Apa hata sepa siri setha sadana jeewanaye matha
Piliganu mena apa bhakthi pooja Namo Namo Matha
Apa Sri Lanka Namo Namo Namo Namo Matha
Oba we apa vidya
Obamaya apa sathya
Oba we apa shakthi
Apa hada thula bhakthi
Oba apa aloke 
Apage anuprane
Oba apa jeevana we 
Apa mukthiya oba we
Nava jeevana demine, nithina apa pubudukaran matha
Gnana veerya vadawamina regena yanu mana jaya bhoomi kara
Eka mavakage daru kela bevina
Yamu yamu vee nopama
Prema vada sema bheda durerada
Namo, Namo Matha
Apa Sri Lanka Namo Namo Namo Namo Matha
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Foreword 

The educational objectives of the contemporary world are becoming more 
complex along with the economic, social, cultural and technological development. 
The learning and teaching process too is changing in relation to human 
experiences, technological differences, research and new indices. Therefore, it 
is required to  produce the textbook by including subject related information 
according to the objectives in the syllabus in order to maintain the teaching process 
by organizing learning experiences that suit to the learner needs. The textbook is 
not merely a learning tool for the learner. It is a blessing that contributes to obtain 
a higher education along with a development of conduct and attitudes, to develop 
values and to obtain learning experiences.

The government in its realization of the concept of free education has offered 
you all the textbooks from grades 1-11. I would like to remind you that you should 
make the maximum use of these textbooks and protect them well. I sincerely hope 
that this textbook would assist you to obtain the expertise to become a virtuous 
citizen with a complete personality who would be a valuable asset to the country.

I would like to bestow my sincere thanks on the members of the editorial 
and writer boards as well as on the staff of the Educational Publications Department 
who have strived to offer this textbook to you. 

W. M. Jayantha Wickramanayaka,
Commissioner General of Educational Publications,
Educational Publications Department,
Isurupaya,
Battaramulla.
2019.04.10    
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  After studying this chapter, you will understand the following:
 ² How to analyze a problem and develop an algorithm
 ² Control structures and their use
 ² Drawing flow charts, writing pseudo codes and conversions between them
 ² Finding alternate solutions to a problem
 ² Programming in Pascal
 ² Evolution of programming languages

1.1  Analyzing a problem
  The raw materials that are used to solve a problem are known as the 'input'. 
The result obtained after solving a problem is known as the 'output'. Converting 
input to output is called the 'process'. A process takes place step by step and it is 
very important to understand the order of the process. When analyzing a problem, 
the input, process and output are identified separately. 
Example -
 Problem 1 : Preparing a letter which can be posted.

 Input :   A sheet of paper suitable to write the letter on and a pen  
       An envelope and a stamp                                
       Glue

 Process :  1. Writing the letter      

   2. Folding the letter and putting it into 
       the envelope
   3. Pasting the envelope   

   4. Writing the recipient's address on the  
       envelope    

   5. Sticking the stamp
 Output :  A letter ready to be posted.
 Note:   Steps No. 4 and 5 in this process can be interchanged.  
   However, the other steps should be followed in the order  
   indicated. 

1 Programming
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Problem 2 : Making a cup of tea

Input :  Tea leaves, sugar, hot water
Process :  1. Putting tea leaves in the strainer
     2. Pouring hot water to the cup through 

       the strainer  
     3. Adding some sugar to the cup
     4. Stirring it well with a spoon
    5. Testing for taste, taking a small sip from the cup
     6. If the taste is not satisfactory, go to step 3 and repeat step

       Nos. 4 and 5
Output :  A cup of tea

Problem 3 :  Dividing 40 page and 80 page books from a parcel of 
              books between two siblings - Sanduni and Anupama.

Input :  The parcel of books
Process :  1. Opening the book parcel
     2. Taking a book out from the parcel 
     3. If it is a 40 page book, giving it to 

        Sanduni
     4. If it is a 80 page book, giving it to  

       Anupama
     5. Go to Step No. 2 till all the books are taken out of the 

       parcel
Output :  Sanduni getting 40 page books
     Anupama getting 80 page books

Problem 4 : Adding two numbers 

Input :  Two numbers 
Process :  Adding the two numbers
Output :  Total

Problem 5 :  Finding the area of a rectangle 

Input :  Length and width of the rectangle
Process :  Area = Length x Width
Output :  Area
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Problem 6 : Finding the larger number between two numbers

Input :  Two numbers
Process :  Comparing the two numbers, finding the larger one
Output :  Larger number

Problem 7 :  Finding whether a number is odd or even

Input :  Number
Process :  Dividing the number by 2

      Deciding that the number is even if 
   the remainder = 0
      Deciding that the number is odd if the remainder = 1

Output :  Indicating whether the number is odd or even

Activity  

1. Identify the input, process and output related to dividing 100 toffees 
among 20 people.

2. Identify the input, process and output in making a kite. 

What are alternative solutions?
If there is more than one solution to a given problem, such solutions are 

called alternative solutions. Such solutions depend on the nature of the problem. 
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Example  
Imagine you come to school by school bus. If the bus breaks down on your way to 
school, you certainly will think of other alternative ways to reach school. Thus, you 
will think of alternative solutions to reach school.

1. Coming to school by another school bus which goes to your school
2. If you have money, reaching the school by CTB or private bus
3. Walking to school along the road
4. Walking to school using a short-cut
5. If you have a way to inform your parents, get their support to reach the 

school
6. Reaching the school by car or motor bike with the support of a trustworthy 

person
You may select a good solution out of these if it is mandatory to go to school that 
day. 
Thus, if there are many solutions (set) to a particular problem, it is suitable to 
consider these and select an appropriate solution.
All the solutions pertaining to a problem are called solution space. In computer 
programming also, various solutions should be identified and an appropriate 
solution should be selected. Then, we can create a short, simple program.

Example 1 
Let us examine the solution space to find the perimeter of a rectangle.
Let us analyze the input, process and output related to this problem.

Input     : Length and width of the rectangle
Process : Calculating the perimeter
Output  : Indicating the perimeter

Let us examine the solution space to calculate the perimeter.
1st solution       Perimeter = length + width + length + width 
2nd solution       Perimeter = length × 2 + width × 2
3rd solution       Perimeter = (length + width) × 2

Out of these solutions, a person who has knowledge only of addition, can select the 
1st solution as the most appropriate. A person who has knowledge of multiplication 
and addition can select the 3rd solution out of the 2nd and 3rd solutions  as the most 
appropriate. The reason for this is, it has the minimum number of additions and 
multiplications. 
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Example 2 
Indicating that a student has failed if the score for the ICT Subject is less than 35, 
and indicating pass if the score is 35 or above.

Input : Marks

Process : Comparing the mark scored with 35

  Solution 1.  If the mark is less than 35
    Result = Fail
        If not
          Result = Pass

  Solution 2.  If the mark is 35 or more than 35
         Result = Pass
          If not 
          Result = Fail

Output : Fail or Pass

Example 3 
Finding the larger number from the given two numbers (See problem 6 in page 3)
Let us consider the two input numbers as n1 and n2.

  Solution 1.  If n1 is larger than n2, the larger number will be n1. 
         If n2 is larger than n1, the larger number will be n2.

  Solution 2.  Subtract n2 from n1.
          If the result is more than 0, n1 is the larger number.

                    If the result is less than 0, n2 is the larger number.

Thus, it is important to select the appropriate solution out of the available alternative 
solutions.
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1.2  Problem Solving using Algorithms
An algorithm is a method to show the steps in solving a problem. An 

algorithm is a step-by-step procedure for solving a problem. The need for this is to 
present a way to solve the problem with a plan.
Example 1 - Let us develop an algorithm to post a letter.

(1) Writing the letter
(2) Folding the letter
(3) Inserting the letter in an envelope
(4) Writing the address
(5)  Sticking the stamp
(6) Posting the letter

Step (1), (2) and (3) in this algorithm should be followed in the given order. 
Step (4) and (5) can be interchanged. The reason for this is, you can either stick the 
stamp after writing the address or write the address after sticking the stamp. 

Thus, there are steps in an algorithm which should be followed in a strict 
sequential order. Sometimes, if the order of some steps is changed, it does not affect 
the process and the output is same.
Example 2 - Let us consider steps in measuring 500g of sugar using a scale.  

 

(1) Putting sugar into a bag
(2) Placing the bag on the scale and getting the reading on the 

scale
(3) If the weight of the sugar is less than 500g, add sugar till 

it weighs 500g
(4) If the weight of the sugar is more than 500g, remove sugar 

from the bag till it weighs 500g
(5) Remove the bag of sugar from the scale when the weight 

is 500g
The algorithm to measure 500g sugar is given above.

Activity  
There are 183 students in a primary school. The principal has 
decided to hold an inter-house sports meet dividing them into three 
houses – Olu, Nelum and Manel. Develop an algorithm to the divide 
the students into the three houses.
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1.2.1  Control Structures

Three types of control structures are used in an algorithms.

  i.    Sequence      

  ii.   Selection       

  iii.  Repetition     

i. Sequence 

If the steps from the beginning to the end of an algorithm are carried out in 
a strict order, it is called a sequence.
Example -

1.  Climbing up or down step by step when going on a staircase

2. Students who were admitted to grade 1 of the school  
     continue studies till grade 13

Activity  

Write down two incidents which consist of sequences.

ii. Selection 

Selection is a situation where step(s) are executed depending on whether a 
condition of an algorithm is satisfied or not. There are two choices; if the condition 
is satisfied, one is selected and if it is not satisfied, the other selection is selected.
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Examples of selection
1. Admitting a child to Grade 1:
   If a child is below 5 years as at 31st of           

 January that year
      The child cannot be admitted to school
      If not
      The child can be admitted to school

2. Passing a subject:
If the mark is 35 or more

      It is a Pass
      If not
      It is a Fail

   3.   Buying a book:
  If you have money equal to or more than 
  the price of the book

        You can buy the book
        If not
        You cannot buy the book

Activity 

1. Write down three incidents which consist of selection.
2. If a Sri Lankan citizen gets the right to vote after completing the age 

of 18, select the most suitable word for the blanks given below.
If the age is ……………… (more/less) than 18
 The vote ……………… (can/cannot ) be casted
If not,
 The vote …………… (can/cannot) be casted

iii. Repetition

If one or several steps of an algorithm are repeated until a condition is 
satisfied, it is called repetition.
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Examples

1. Let us consider the process of a class teacher 
marking the attendance register.

(1)   Call the first name on the register
(2)   Mark 1 if the student is present
(3)   Mark 0 if the student is absent
(4)   Call the name of the next student
(5)   Repeat step (2) or (3) and (4)  till the  
        last name of the register is called

2. Let us consider the process of reading a paragraph 
and calculating the number of words you read.

(1)   Read the first word of the paragraph
(2)   Number of words = 1
(3)   Read the next word
(4)   Add 1 to the number of words
(5)   Repeat step (3) and (4) till the end of the paragraph
(6)   After reading the paragraph, indicate the number of words

Activity

1. Write down as steps, two scenario that comprise repetition.
2. Fill in the blanks below related to repetition that output 5 

times from 5 to 60.
I. n = 5
II. Output the value of n.
III. Add 5 to the value of n.
IV. Repeat step number ……… and ……….. till the value 

of n = 60.

1.3 Representation of an algorithm
Flow charts and pseudo codes are used as tools to present an algorithm to 

make the algorithm understand better.
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1.3.1 Flowcharts

Flowcharts are used to present how the algorithm is built step by step in a 
dramatic manner. The symbols given in table are used to indicate different functions. 
(See Table 1.1)

   Table 1.1

Symbol Function
Start or end

Input or output

Process

 Decision

 Flow direction

Connector

Sequence
 In sequence the steps from the beginning to the end are executed in order.
E.g. 1 - Finding the area of a circle.

Input the radius of the circle

Calculate the area of the circle

Start

End

Output the area of the circle
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Selection
The selection indicates the flow of direction depending on a condition being 

satisfied or not.
E.g. - Finding whether a number is odd or even

Input the number

Find the remainder when the 
number is divided by 2

Is the remainder 0?
No 

An odd num ber          

Yes
An even number                   

Start

End

Repetition
A step or several steps are repeated till a condition is satisfied or are 

continued till it is satisfied.
E.g. - Finding the total of some numbers

Get the number N

Total = 0

Total = Total + N

Are there any more 
numbers?

Output the Total                                                                                      
No

Yes

Start

End
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Activity  

Draw flow charts to solve the problems given below.
1. Find the perimeter and area of a rectangle.
2. It is decided to add Rs.5000 to the basic salary of the employees of 

a company. Calculate the new salary.
3. When posting a letter, postal fare is charged according to its weight. 

The standard fare should be paid for letters which are equal to or 
less than the standard weight. An additional fare should be charged 
if the weight is more than the standard weight. 

4. Indicate the first 12 multiples of 7.  
5.   Draw flow charts for the examples in selection 1:2:1.

1.3.2 Pseudo codes

When an algorithm is presented in simple English terms it is called a pseudo 
code. Pseudo codes are independent of a computer language. Pseudo codes can be 
converted to any programming language instructions. Hence, pseudo codes make 
computer programming easier.
Let us see simple English terms used in an pseudo code.

BEGIN - To indicate a beginning
END  - To indicate an end
INPUT , READ , GET - To indicate an input
OUTPUT, DISPLAY , SHOW  - To show an output
PROCESS, CALCULATE - To indicate a process
IF … THEN .. .ELSE  … ENDIF  - Used to indicate a selection
FOR – DO
WHILE – ENDWHILE }  Used to indicate a repetition
REPEAT - UNTIL

Writing pseudo codes
E.g. 1 - Finding the area of a circle

 BEGIN
  INPUT Radius 
  CALCULATE Area = 22/7 « Radius « Radius
  DISPLAY Area

 END.
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E.g. 2 - Finding whether a number is odd or even
   BEGIN

  READ number as N
  CALCULATE  Remainder after number is divided by 2
  IF Remainder = 0 THEN
   DISPLAY “Even number”

     ELSE
   DISPLAY “Odd number”
  ENDIF

     END.

E.g. 3 - Finding the total of some numbers

BEGIN
  Total = 0
  REPEAT
   READ Number as N
   CALCULATE Total = Total + N
  UNTIL numbers are over
  DISPLAY Total

END.

E.g. 4 - Finding the total and the average of 10 numbers 

BEGIN
  Total = 0
  Average = 0
  n = 1
  WHILE n <= 10

   READ Number 
   CALCULATE Total = Total + Number
   n = n + 1
  ENDWHILE
  CALCULATE Average = Total/(n - 1)  
  DISPLAY Total, Average

END.
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Following are some of the facts about the above pseudo code.
 ² Total, Average and Number are variables.

° When values are assigned to number variable, the value of Total, Average 
and n variables change.

 ² n indicates the number of repetitions. (Number of times the loop is executed)
 ² The statements Total = 0 and Average = 0, makes starting values of these 

variables assigned as 0.
° Hence, the initial value of Total and Average are 0s.

 ² The statement n = 1, makes the starting value of n is assigned to 1.
 ² n <= 10 is the condition that should be satisfied.
 ² WHILE n <= 10 indicates that the loop n should be repeated until value of n is 

10.
° Repetition occurs when the value of n is 10 or less than 10. This means, 

till the condition n <=10 is true, repetition occurs. When the value of n 
becomes 11, the repetition stops. Then the condition becomes false. 

 ² READ denotes getting a value for Number variable.

 ² Total = Total + Number denotes the 
present value of Total is added to 
number and the resultant value is 
assigned on the new value of Total.

 ² n = n + 1 calculates the number of 
repetitions. 1 is added to the present 
value of n and the result is assigned 
to n.

 ² ENDWHILE indicates the limit to 
end repetition. Hence, only READ 
number, Total = Total + Number and n = n + 1 are repeated till the condition n 
<= 10 is fulfilled.

 ² When the repetition stops, the value of n is 11 and the condition is false. 
 ² By Average = Total/(n - 1) , final value of Total is divided by (n – 1) and that 

value is assigned to Average variable. 
 ² DISPLAY (Total, Average) produces the output of the total of 10 numbers and 

its average.  

Totaln

1+1=2

number

number

numberTotal

Total

2+1=3

0+12=12

12+15=27

n

n
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Observation

 ² When a value is assigned to a variable, the previous value is 
lost. 

 ² When the statement Total = Total + Number is executed, the 
value assigned to the Number variable is added with the value 
assigned to Total variable and the result obtained is assigned 
to the Total variable. 

 ² Total = Total + Number is not a mathematical formula.

1.3.3  Converting flow charts to pseudo codes

An algorithm can be presented in a flow chart as well as in a pseudo code. 
Hence, let us examine how a flow chart can be converted to a pseudo code. 

Start 

Stir tea

Add sugar

Water boiled?

Want sugar?

No

No

Yes

Yes

Pour water in Cup

Put tea bag in cup

End

Boil water

BEGIN

 Put tea bag in cup

 WHILE (not water boiled)

  Boil water

 ENDWHILE

 Pour water in cup

 WHILE (sugar needed)
  Add sugar
  Stir tea

 ENDWHILE

END
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E.g. 1 - Finding the larger number from two different numbers

Input the two numbers 
N1, N2

Is N1 larger than 
N2? No 

Yes

Output the larger 
number                                                                    

Larger number is N1          

Start

End

Larger number is 
N2                

 BEGIN
  READ N1, N2
  IF N1 > N2 THEN
   Large = N1
  ELSE
   Large = N2
  ENDIF
  DISPLAY Large
 End.

E.g. 2 - Finding the smallest number from 10 input numbers

Input N

No

Yes

Input the number N

Output Min                                                                                    Count < 10 ?

No 
Yes

Min =  N
Count =1

N < Min ?

 Min =  N

Count = Count + 1

Start

End
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BEGIN
  INPUT Number as N
  Min = N
  Count = 1
  WHILE Count < 10
   OUTPUT Number as N
   IF N < Min  Then
    Min = N
   ENDIF
   Count = Count + 1
  ENDWHILE
  PRINT  Min

END.

1.4  Pascal programming

1.4.1 Identifiers 

An identifier is a term used to represent a variable, constant or a program. 
The following are some rules that should be followed in declaring an identifier.

Var year : integer; 

data type

integer

reserved word variable identifier
 ² Reserved words in Pascal cannot 

be used as an identifier name. 
In any programming language 
reserved words cannot be used as 
identifiers.
E.g. - BEGIN, END are not valid
(E.g. - A-Z, a-z)

 ² Should start with an English letter.
 ² After the first letter of the identifier, letters (a-z, A-Z) or numbers (0-9) and 

underscore ( _ ) can be used.
E.g. - Student_name

 ² Not case sensitive (E.g. - Art, art, ART will be the same identifier)
 ² There should not be any space between words.

E.g. - Student Name - Not valid



18 For free distribution

 ² The special characters such as the following should not be included in an 
identifier.

            ~    !   @   #   $  %   ^    &   *   (  )    -   +  =  {  }  [  ]  :  ;  ‘  “  <> ?  ,  .  /  |  \
but, only underscore ( _ ) is valid. 

 ² Use of meaningful terms for identifiers can make program easily understood.
Examples of valid identifiers
Sum, SUM, Total_Nos, Num1, FirstName, Last_Name

Examples of identifiers that are not valid
$75, Average Marks, 9A, Last-name

1.4.2 Reserved words

The reserved words in Pascal, are defined in Pascal language. Hence, 
reserved words are not used as identifiers.

Reserved words are different from language to language. The following are 
reserved words used in Pascal.

exports
file
for
function
goto
if
implementation
in
inherited
inline
interface
label
library

mod
nil
not
object
of
or
packed
procedure
program
record
repeat
set
shl

shr
string
then
to
type
unit
until
uses
var
while
with
xor
ate
to

and
  
asm
array
begin
case
const
constructor
destructor
div
do
downto
else
end
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1.4.3 Standard data types in Pascal

When a program is executed, the input and output should be stored in 
computer memory. The space needed for each is defined according to the data type. 
Hence, it is essential for a programmer to have knowledge of data types. 

The following are data types and their ranges.

Integer - Plus or minus whole numbers 

 E.g. - 0, 46, -12

Real - Plus or minus decimal numbers 

E.g. - 0.0, 25.68

Boolean

 True or False

Char - Any character of the key  
 board 

 E.g.  - ‘k’, ‘#’, ‘7‘ 

String - Any sequence of characters

 E.g. - ‘ICT’, ‘programming’, ‘Sri Lanka’

Important

Values of Char and String are included inside single quotation ‘ ’.

1.4.4 Variables and constants

Variable

A variable is an identifier which changes the values given to it when the 
program is being executed. 
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In Pascal, “var” is used to declare variables. 
Retrive Store

E.g. -  var  count : integer;
var  a,b : real;
var  n1, n2 : integer;

  Avg : real ;
  Pass : boolean;
  Character : char;
  Name,school : String;

Important

A variable has a name, and it stores a value of the declared type.

Constants

The identifiers which do not change their values while the program is 
executed are called constants. In Pascal, “const” is used to declare a constant.

Example
Const   max = 100;
Const   pi = 22/7;

Observation

 ² When executing a program, a variable can take different 
values. However, the value of a constant remains unchanged.

1.4.5 Operators

Operators are required to perform calculations, comparisons, and to evaluate 
logical expressions. Hence, operators are essential in programming.
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Basic types of operators 

  1. Algebra operators  

       Operator                Usage                       Example expression          Result
            +      Addition   6 + 3  9

-  Subtraction    7 - 5  2
*   Multiplication   2 * 5  10
/  Division   10/4            2.50
DIV  Division of round numbers  20 DIV 6 3
MOD   Remainder after division     20 MOD 6 2

3
6 20

18
2

DIV

MOD

2. Comparison operator

Comparison operators are used to compare values or expressions. The final 
result of an expression which consists of a comparison always takes a Boolean 
value. Hence expression will be True or False.

      Function                Usage                    Example expression           Result
>  Greater than      7 > 3       True 
>=  Greater than or equal     8 >= 8       True
<  Less than      3 < 2      False  
<=  Less than or equal      4 <= 6          True
=  Equal          3 = 1      False
< >  Not equal      2 < > 5       True

3. Logical operators

Logical operators are used to combine two or more expressions. For further 
study on this refer. basic logic gates that you learnt in Grade 10.
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i)  AND operator

AND operator takes the form “(First Expression) AND (Second 
Expression)”. Depending on the first expression or second expression being True 
or False, the result becomes True or False. The following table shows the function 
of AND.

First Expression Second Expression (First Expression) AND (Second 
Expression)

False False False
False True False
True False False
True True True

Example 
1. (Rain fall > 56) AND (Temperature < 30) 
2. (Height > 60) AND  (Age < 15)
3. Let us consider, (3 >= 2) AND(3 < > 3)
        3 >= 2 is True. 3 < > 3 is False. Hence, the result of the expression is False.

Important
 � If at least one operator out of the two operators is false, the AND 

evaluates to false.
 � When only both operators are true, the expression of AND 

evaluates to true. 

ii)  OR operator

OR operator takes the form “(First Expression) OR (Second Expression)”. 
Depending on the first expression and second expression being True or False, the 
result of OR is True or False. The following table shows the function of the OR 
operator. 

First expression Second expression (First expression) OR (Second 
expression)

False False False
False True True
True False True
True True True
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Example
1.  (Temperature > 30) OR (Rainfall < 55) 
2.  Let us consider, (3 >= 2)  OR (3 < > 3) 

          3 >= 2 is True. 3 < > 3 is false. Hence, the result of the expression is true.

Important
 � When at least one operator out of the two operators is true, the 

OR operator evaluates to true.
 � When only both operators are false, the expression of OR operator 

evaluates to false.

iii)  NOT operator

A True expression is always evaluated as false with a NOT operator while a 
false expression is always evaluated as true.

Expression NOT (Expression)
False True
True False

Example  
1. NOT (Temperature > 30) 
2. NOT(5 = 5) is indicated as false statement.
     Therefore 5 = 5 is a true expression. Hence, the statement NOT (5 = 5) is 

indicated as false 

Operator precedence

When Pascal expressions are evaluated, the order of precedence is given 
below. 

Priority order     Operator
1   NOT
2   * / DIV MOD AND
3   + - OR
4   = < > < <= > >= less

high
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Evaluating expressions

E.g. 1     E.g. 2    E.g. -3
5 + 14 MOD 4       3 + 7 DIV 2    16 / 4 * 2
5 + 2     3 + 3    4 * 2
7     6    8

E.g. 4     E.g. -5
NOT (8 MOD 2 > 5)   4 >= 4 AND NOT(7 > 9) 
NOT (0 > 5)    True AND NOT(False)
NOT(False)    True AND True
true     true

Let us identify the basic components of a normal Pascal program.

program addNum (input,output); Name of the program (addNum) 
var              num1,num2,total : integer; } 

Declaring the variables            avg: real;

Begin    Beginning of the main program

          avg: real;

Beginning of the main programBegin

Write(‘Welcome Pascal Programming’);
{calculate total and  average of two numbers}  
Writeln(‘Enter First Number’);
Read(num1);
Writeln(‘Enter Second Number’);
Read(num2);
total: =num1 + num 2; } Expressions which indicate 

the processavg := total/2;
writeln(‘Total is ‘ , total);
writeln(‘Average is ‘ , avg);

Output
Input

Indicating 
comments  

End.  Ending of the main programEnding of the main programEnd.
Note : To write comments (*..............*) can also be used.

 ² “program”, “input” and “output” are reserved words.
 ² “addNum” is an identifier. This is the name of the program. It is not essential to 

indicate input, output within brackets with the program name.
 ² read( ) and readln( ) functions words are used for input.

 ¾ Data is input to num1 variable through Read(num1); 
 ¾ Data is input from readln() from a new row.
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 ² write( ) and writeln( ) functions are used for output.
 ¾ From the function Write(‘Welcome Pascal Programming’) outputs 

'Welcome Pascal Programming'.
 ¾ The function writeln(‘Average is ‘ , avg); prints the value of the Avg 

variable in a new line.
When writing Pascal statements;

=

num 1

3.4

num 2

2.3

Total

5.7 +

 ² Semi-colon (;) is used at the end of an 
statement. Semi-colon indicates the end of 
an statement.

 ² What happens with the expression  
total :} num1 + num2 is that it adds the 
variables num1 and num2 and assign result 
to the variable 'total'

 ² “:}’’ is the assignment operator.

   

i: integer 
i := 4;

1.4.6 Selection

IF statement

If condition structure is as follows. 

Statement(s)

Is the condition 
True?

No

Yes

Pseudo Code

IF  Condition  THEN
 Statement(s)

ENDIF

Flow chart

               



26 For free distribution

There are two types of IF statements.
i) IF... THEN.... ENDIF
Here, the statement will be executed if only the condition is satisfied. 
E.g. 1 - If the input number is only positive, print the number.

Program positiveNo(input, output);
Var  N : integer;
Begin
    Writeln(‘Enter Number’);
    Read(N);
 If N > 0 then
    Writeln(‘Positive Number’);
End.

Get the number (N)

Is N > 0?
No  

Yes  
Print N 

End

Start

Pseudo Code

Begin
   Input N
   IF  N > 0  
THEN
 Print N
   ENDIF
End.

Flow chart 

Pascal Code         

ii) IF... THEN.... ELSE .......... ENDIF  

If the condition is satisfied Statement 1 is executed if not Statement 2 is 
executed. The If condition structure is as follows. 

Is the condition 
True? 

No 

Yes 
Statement 1

Statement 2

IF  Condition  THEN

 Statement1

ELSE
 Statement2

ENDIF
Pseudo CodeFlow chart
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E.g. 2 - Finding the larger number from two unequal numbers.

program LargeNo(input,output);
Var  N1,N2,Large: integer;
Begin
 Writeln(‘Enter Two Numbers’);
 Read(N1,N2);
 If N1 > N2 then
  Large :} N1
 Else
  Large :} N2;
 Writeln(‘Large Number is ’ , Large);
End.

Pascal program  

Nested IF

When there are multiple conditions one after the other, Nested IF is used.

i) Use of Nested IF when there are multiple conditions for a single variable

E.g. 3 - Finding the Grade when the marks scored by a student for a subject is given 
                as input.

Get marks (M)

Is M >= 75?
No No  No  No 

Yes Yes Yes Yes

Is M >= 65? Is M >= 50? Is M >= 35?

Result = ''A'' Result  = ''B'' Result  = ''C'' Result  = ''S'' 

Result  = ''F'' 
Output result

Start

End

Flow chart
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Begin
 Input Marks as M
 IF M >= 75 Then 
       Grade = ‘‘A’’
       ELSE
       IF M >= 65 then
             Grade = ‘‘B’’
             ELSE
             IF M >= 50 then
         Grade = ‘‘C’’
         ELSE
         IF M >= 35 then
   Grade = ‘‘S’’
   ELSE 
   Grade = ‘‘F’’
          ENDIF
  ENDIF
         ENDIF
 ENDIF
 Display Grade
End.

program GradeForMarks (input,output);
Var   M: integer;
 Grade: char;
Begin
 Writeln(‘Enter Marks’);
 Read(M);
 If M >= 75 then
     Grade :} ‘A’
 Else 
     If M >= 65 then
 Grade :} ‘B’
                Else
          If M >= 50 then
  Grade :} ‘C’ 
        Else
  If M >= 35 then
      Grade :} ‘S’
  Else
      Grade :} ‘F’;
 Writeln(‘‘Grade = ’’, Grade);
End.

  

  
Pseudo Code              Pascal Code  

Using CASE statement when a variable has multiple conditions

Rather than using IF…. THEN…  ELSE…  ENDIF if conditions repeatedly, 
it is easier to use CASE statement.

Flow chart

Get marks (M)

Marks

0-34 50-64  65-74 75-100
Result = ''W'' Result = ''C'' Result = ''B'' Result = ''A'' 

Output grade

Result = ''W'' 
35-49 other

Indicate marks as invalid

Start

end
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program FindGrade(input,output);
var Marks : integer;
 Grade: char;
Begin
 Writeln(‘Enter Marks’);
 Read(Marks);
 Case Marks of
        0..34 : Grade :} ‘W’;
        35..49 : Grade :} ‘S’;
        50..64 : Grade :} ‘C’;
        65..74 : Grade :} ‘B’;
        75..100 : Grade :} ‘A’;
 Else
             Writeln(‘Invalid Marks’);
 End;
 if (Marks >= 0) AND (Marks <= 100) then
  Writeln(‘Grade is ’ , Grade);
End.

 Pascal program    

1.4.7 Repetition

Let us examine how repetition structures are used when the number of 
repetitions is known in advance.

i) FOR – DO structure (1st Method)

FOR  Variable :} Value_1 TO Value_2 DO

 ² The data type of Variable , Value_1 and Value_2 should be integer.
 ² The value of Value_2 should be larger than Value_1 to start repetition.
 ² Repetition is started with Value_1  and ended with Value_2.
 ² Hence, FOR – DO structure can be used when the number of repetitions is 

known in advance.  

Repetition structure Starting 
value

Ending 
value

Number of repetitions

FOR X :}1 TO 5 DO 1 5 5
FOR X :} 0 TO 4 DO 0 4 5
FOR X :} 5 TO 10 DO 5 10 6
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E.g. - Printing the values from 1 to 10

Program print10Nos(input,output);
Var  count : integer;
Begin

For  count :} 1 to 10 do
Writeln(count);

End.
Here the count variable value is changed from 1 to 10 while printing the 

output values, and two loop is executed 10 times.

ii) FOR – DO  Loop (Method 2)

FOR  Variable :} Value_1 DOWNTO Value_2 DO

 ² The value of Value_1 should be smaller than Value_2 to start repetition.
 ² Repetition is started with Value_1 and ended with Value_2.

Repetition structure Starting value Ending value Number of 
repetitions

FOR X :} 10 DOWNTO 5 
DO

10 5 6

FOR X :} 4 DOWNTO 0 DO 4 0 5

E.g. - Printing of values from 10 to 1

Program print Reverse (input,output);
Var  count : integer;
Begin

For  count :} 10  downto 1 do
Writeln(count);

End.

Count variable value is changed from 10 to 1 while printing the output and 
and the loop in executed 10 times.
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Finding the total and average of ten numbers

A block of statments in 
repetition.

program total_avg (input,output);
var  I,num,total : integer;
 avg: real;
Begin
 total :} 0;
 for I :} 1 to  10 do
 begin
   writeln(‘Enter Number’);
   read(num);
   total :} total+num;
 end;
   avg :} total/I;
   writeln(‘Total is ‘ , total);
   writeln(‘Average is ‘,avg);
 end.

}
Important

A block of statements indent properly is written between 'begin' and 
'end'; inside the FOR loop.

When the number of repetitions are not known in advance, ''While do'' or 
''repeat until'' structures are used.

i) WHILE DO Loop

 ² Conditions are checked at the beginning of the loop.
 ² Statements inside the loop are executed (ie: a loop that runs for ever) only if the 

condition is true.
 ² Statements inside the loop never executed if the condition is false.
 ² The condition becomes false at the end of the repetition.
 ² If the condition does not become false while the repetition is executed, it will 

be an infinite loop.

E.g. 1 -  while number > 0 do 
  Repetition is executed if only the value of the variable number is positive.  

E.g. 2 - number :} 1;
    while number <= 10 do

  number :} number + 1;
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◦ Condition is true since the starting value of the variable 'number' is 1.
◦ Hence, the repetition is executed.
◦ Each time loop is executed, 1 is added to the value of ''number''.
◦ Hence, Loop is executed when the value of ''number'' is 10 or less than 10.
◦ Loop stops when the value of the ''number'' variable is 11.

ii) REPEAT UNTIL Structure

 ² Condition is not checked at the beginning of loop.
 ² Condition is checked, after the statements are executed once.
 ² Loop is started if the condition is false only.
 ² Loop stops when the condition becomes true.
 ² If the condition does not become true while the loop is executed, loop will be 

an infinite loop.

E.g. 1 -
count = 0;
Repeat

  writeln  ^‘Pascal’&;
  count :} count + 1

Until count > 5;

◦ The starting value of count variable is 0.
◦ The word Pascal is displayed on the screen.
◦ 1 is added to the count variable.
◦ It is checked whether the value of 'count' variable is larger than 5.
◦ Loop is executed till the value of the 'count' variable becomes 5.
◦ Loop stops when the value of count is 6.
◦ When the Loop stops, the word Pascal is displayed six times on the screen.

E.g. 2 -

sum :} 0;
repeat

  sum :} sum + 5;
  writeln(sum);

until sum < 50;
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 ² The starting value of sum variable is 0.
 ² 5 is added to the value of sum.
 ² The value of sum is 5 and it is displayed on the screen.
 ² It is checked whether the value of sum variable is less than 50.
 ² The condition sum < 50 is satisfied (True).
 ² Hence, Loop stops.

E.g. 3 -
sum :} 0;
repeat

  sum :} sum + 5;
  writeln^sum&;

until sum >= 50;

 ² The starting value of sum variable is 0.
 ² 5 is added to the value of sum.
 ² The value of sum is displayed on the screen.
 ² It is checked whether the value of sum variable is greater than or equal to 50.
 ² Loop is executed till sum >= 50 condition is satisfied (True).
 ² When the loop stops, the value of sum is 50.
 ² Loop is executed 10 times.
 ² Multiples of 5 from 5 to 50 will be given as output.

1.4.8  Nested control structures

Inside an algorithm, a control structure(s) may be included inside another. 
For example, a repetition loop may be included inside another repetition. Similarly 
a selection may be included inside another selection. Hence nested controlling 
structures should be used in programming.

1.4.8.1 Repetition inside selection

A repetition may be executed depending on a condition of a selection being 
satisfied or not.

E.g. - Depending on the user’s selection, an ascending or descending number 
            sequence can be produced as output.
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program orderNos(input,output);
var  num:integer;
 cho:char;
begin
     writeln('Select Assending(A) or Desending(D)');
     read(cho);
     if cho = 'A' then
        begin
             writeln('Asending Order');
             for num :} 1 to 6 do
                 writeln(num);
        end;
     if cho = 'D' then
         begin
              writeln('Desending Order');
              for num :} 6 downto 1 do
                  writeln(num);
         end;
end.

1.4.8.2 Selection in repetition

 Let us consider how selection takes place while the repetition control structure 
being executed.

E.g. - Determining whether the numbers input by the user are odd or even and
           calculating the total number of odd, even numbers separately. 
program rep_sel(input,output);
var num,rem,count,e_count,o_count:integer;
begin
     for count :} 1 to 10 do
         begin
              writeln('Enter Number');
              read(num);
              rem :} num mod 2;
              if rem = 0 then
                 begin
                      writeln('Even number ');
                      e_count :} e_count+1;
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                 end
              else
                  begin
                       writeln('Odd number ');
                       o_count :} o_count + 1;
                  end;
         end;
     writeln(e_count,'Even Number/s');
     writeln((o_count ,'Odd Number/s');
end.

1.9.1 Arrays

It is essential in programming to use variables to store data items in 
memory. Further, such variables have suitable data types. Various variables which 
are different in names are needed to store data items which belong to the same data 
type.

E.g. - For instance, five variables are needed to save five round numbers in the 
           memory. Before using such variables, they should be declared as given below.
Var p, q, r, s, t : integer;  

n1, n2, n3, n4, n5 : real;

1.4.9.1 Use of arrays

An array is used to save data items of the same type in memory using a 
single variable identifier name. Hence, use of array enables to store data as required 
under a single variable identifier name without providing different variable names 
to each item.

  
Each cart holds a 

single piece of data
Here comes the data 

train
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1.4.9.2 Defining a one-dimensional array

This is a data structure used to save data of the same type sequentially. An 
array uses a group of adjoining memory spaces. A one dimensional array can be as 
follows.

Var  Name_of_Array ( array [first index .. last index] of data type

E.g. - var marks ( array [0''9] of integer;

 ² From this, the array named marks is defined which can include 10 whole 
numbers.

1.4.9.3 Attributes of an array

 ² Elements of an array are positioned next to each other. (re adjacently)
 ² The index of an array (sequential number) is indicated with the array name in 

square brackets.

M[0]

X[0]

M[1]

X[1]

M[2]

X[2]

M[3]

X[3]

M[4]

X[4]

First element
lowest index

Last element 
highest index

Array Name Index

element 1 element 5



For free distribution 37

E.g. - the size of the array Var M : Array[0..4] of integer;  is 5.
From M[0] to M[4], it consists of 5 elements.  
Index is indicated in square brackets.
Depending on the way array is defined, index positions get changed.

E.g. - ; Var X : Array[1..5] of integer;
Only data items which belong to the same type can be stored in the array.

Any element of the array can be accessed randomly. Hence, an array can be 
accessed easily through a repetition control structure.  

E.g. - Entering Maths marks of 40 students into an array
var  maths : array[0..39] of integer;

i,marks : integer; 
for i :} 0 to 39 do

begin
  writeln(‘Enter marks’);
  read(marks);
  maths[i] :} marks;

end;

1.4.9.4 Assigning values to an array

Let us consider integer array with 5 five elements which can input whole numbers. 

num[0] num[1] num[2] num[3] num[4]

45 36 60

45 75 36 81 60

var   num : array[0..4] of integer;

num[0] :} 45; 

num[2] :} 36,num[4] :} 60;

num[1] :} num[4] + 15;
num[3] :} num[0] + num[2]
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1.4.9.5 Declaring values of an array

The elements declare the values of an array. 
writeln ^num[3]&;     Print the 4th element (81)
writeln ^num[1]" num[4]&;   Declaring  2nd and 5th elements (36, 60)
for  x :} 0 to 3 do     Print the first 4 elements of the array (45, 75,
                  36, 81) 
writeln ^num[x]&; 
for  x :} 2 to 4 do       Print the 3 elements - 3rd, 4th, 5th - of the array
        (36, 81, 60) 
writeln ^num[x]&; 
for  x :} 0 to 4 do     Print all the elements of the array (45, 75, 36,
       81, 60) 

E.g. - Entering Information and Communication Technology marks of 35 students,
          determining the highest mark and calculating the average.    
program ictMarks(input,output);
var marks : array[0..34] of integer;
    i,tot,max : integer;
    avg : real;
begin
     for i :} 0 to 34 do
         begin
              writeln('Enter Marks');
              read(marks[i]);(* Read Marks to array *)
              tot :} tot + marks[i];(* Add marks *)
         end;
     avg :} tot/35;
     max :} marks[0];
     for i :} 1 to 34 do
         if marks[i] > max then max :} marks[i];
     writeln('Maximum marks = ', max);
     writeln('Average marks = ',avg);
end.

1.4.10 Use of sub - programs

As a program becomes complex, when the number of sub processes increase, 
it will be difficult to read and understand and also to maintain. Therefore, using sub 
programs as much as possible while writing useful.
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sub - 
problem 1

sub - 
problem 2

sub - 
problem n

Main 
problem

sub - program 1
-----------------       

-----------------

sub - program 2
-----------------       

-----------------

sub - program n
-----------------       

-----------------

1.10.1 Types of sub - program

There are two types of sub - programs in addition to the main program. A sub 
- program which returns an output back to the main program and a sub - program 
which does not return an output back to the main program. A sub - program which 
returns an output back is called a Function and a sub - program which does not give 
an output is called a Procedure.

1.10.2 Introducing sub - programs

PROGRAM 
CONST 

VAR Function and 
procedure 
declaration

Main 
program

BEGIN

END

Before starting the main program, functions and procedures should be 
declared. Sub - programs can be called for in the main program. (Calling a function 
or a Procedure).
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The following is the syntax to define a procedure.
Procedure  Name_of_Procedure( name_of_variable : data type);
E.g. - Procedure to find the area of a circle

Procedure calculateArea(var radius:real); 

Function  Name_of_Function(name_of_variable : data type) : data type ;

E.g. - Function to find the area of a circle
Function calculateArea(var radius : real): real ;

The following syntax define a function.

Return Output 

Calling the procedure

Calling the function

Procedure sub1(var x:real);
begin
 statement
 ………………
end; 

Function sub2(var x:real): 
real ;
 begin
  statement
  ………….
 end;

begin
 statement
 ………………
 sub1(value);
 ………………
           V = sub2(value);
 ………………
 statement
end.

 

Procedure declaration

Function declaration

Main Program

{
{
{

E.g. - Let us consider the program to calculate the area and circumference of a 
           circle. 
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1. A program built with procedures

program procedure_circle(input,output);
const pie = 22/7;
var radius:real;

procedure getData(var radius: real);
          begin
               writeln('Enter Radius');
               read(radius);
          end;
procedure processArea(var radius:real);
          var area:real;
          begin
               area :} pie * radius * radius;
               writeln('Area = ',area);
          end;
procedure processCircumferance(var radius:real);
          var circum:real;
          begin
              circum :} 2 * pie * radius;
              writeln('Circumferance = ',circum);
          end;
begin
     getData(radius);
     processCircumferance(radius);
     processArea(radius);
end.

2. A program with functions

program function_circle(input,output);
const pi = 22/7;
var radius:real;

function processArea(var radius:real):real;
          var area:real;
          begin
               area :} pi * radius * radius;
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               processArea :} area;
          end;
function processCircumference(var radius:real):real;
          var circum:real;
          begin
              circum :} 2 * pi * radius;
              processCircumference :} circum;
          end;
begin
     writeln('Enter Radius');
               read(radius);
     writeln('Circumference = ',processCircumference(radius));
     writeln('Area = ', processArea(radius));
end. 

1.5 Evolution of programming languages

1.5.1  Need of a programming language

Hello Mr. 
Computer?Computer?

'1010101010101010'
A program is a sequence of instructions 

which is designed to perform a certain task 
is using the computer. A computer language 
is needed to provide the instructions. 
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1.5.2  Low level programming languages

Machine language

This is a language which can be directly understood by the computer. 
Binary numbers such as 0s and 1s (bits) are used to provide instructions. Hence, the 
processor could directly run a program written in a machine language.

A program written in machine language has the following features;
 ² Could be executed directly on the machine
 ² Fast in operation
 ² No need of language translating programs to translate the program into binary
 ² Dependency on machines (a program written to one computer may not run 

on another computer)
 ² Difficult to understand by humans as it is written using 0 and 1.

Assembly language

Instead of commands written in a machine language using 0 and 1,  assembly 
language is designed to use simple symbols.

A program written in assembly language has the following features:
 ² Operation is comparatively slower than the machine language.
 ² Assembly language should be translated to instructions using the language 

translating program called assembler.
 ² Dependency on machines (a program written for one computer cannot be 

run on another computer.)
 ² The use of symbols makes it more simple to understand.

A program written in 
Assembly language

 Machine language 
instructionsAssembler

1.5.3  High-level programming languages

Languages which are designed with simple English words enabling the 
programmer to understand it easily are called high-level computer languages.
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Examples for high level computer languages
FORTRAN, BASIC, COBOL, PASCAL, C 

FORTRAN Pascal C 

High-Level Language

Assembly language

Machine language

Hardware

A program written in a high-level 
language has the following features:

 ² Easy to understand.
 ² Need to be translated to machine 

language instructions before executing 
on a computer.

 ² Does not depend on the machine.

1.5.4  Programming language types 

Programming is a creative task where a computer programmer provides 
instructions to the computer on how to perform a particular task. A program can be 
defined as a set of instructions which instructs the computer which task should be 
carried out to find a solution to a certain problem.

There are many different approaches to computer programming. These are 
called programming paradigms. Different approaches develop solutions to problems 
using programs using different paradigms. Even though most of the programming 
languages come under one paradigm type, certain languages show elements related 
to different paradigms.

Paradigms

  Declarative Imperative

Logic
Functional 
Dataflow Database Procedural

Object 
Oriented

Parallel 
Processing

•   C •   Java •   Java •   Prolog •   Lisp •   SQL
 Programming Paradigms
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Imperative/ 
Algorithmic

Declarative Object-
OrientedFunctional Programming Logic  Programming

Algol
Cobol 
PL/1 
Ada 
C

Modula - 3

Lisp
Haskell

ML
Miranda

APL

Prolog Smalltalk
Simula 

C++ 
Java

There are a number of programming languages. There are differences 
among different programming language types.

Difference between procedural and declarative paradigms

A procedural language is a computer programming language which consists 
of a well structured set of steps and procedures. This includes statements for problem 
solving steps.
Example -            

Data is 
exchanged 
between 

procedures

Declarative Procedure

Procedural Programming

Procedure 1

Procedure 2

Procedure 3

Declarative Procedure

Code

Data
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The Pascal programming has procedural paradigm features.
A declarative paradigm develops a structure and elements of computer 

program by indicating calculations and/or logic without a control flow. This helps to 
reduce or eliminate side effects. In declarative programming, program is designed 
to solve problems explaining what you want rather than stating how to solve the 
problem as in primary programming languages. The program itself does not explain 
how it is executed. This means the computer is provided only what the problem and 
the required solutions are, not how to solve it. The computer finds solutions related 
to the given problem. This is completely different from procedural paradigms which 
execute algorithm as explanatory steps. Declarative paradigms related to Artificial 
Intelligence.

Important

Procedural Paradigm

Saying how you achieve it

A
B
C

1. K eep block A                                            
2. Keep block B on top 
    of  block A
3. Keep block C on top 
    of block B

  
Declarative Paradigm

Saying what you want

A
B
C A pillar which 

consists of 3 
blocks

Comparison of structured and object oriented paradigms

A structured program is a logic based paradigm and it is the pre discussed 
object oriented program. A structured programming paradigm provides facilities to 
understand and modify the program. The system is divided into sub systems and 
there is a top – down flow in it.

Informs the user to enter data

Retrieves data entered by the user

User is given the output

Data is processed

Structured Program
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The Pascal programming has the structure of structured programming as 
well.

 Object 

Property Method 

Object oriented programming is a 
programming paradigm based on the concept 
of objects. Objects consists of data and 
methods. Methods are codes that are in the 
form of procedures that handle data. These 
data structures exist in the form of fields which 
are called Attributes. Class is the basic structure of object oriented programming. 
Class describes the behaviours of data and instances. Class can create objects of 
same type.

An object-oriented program consists of many objects interacting 
with each other by sending messages

System

Record loans Add 
resources

Report fines

Structured Approach
Decompose by functions or processes

Library Information Systems

Catalog

Book

Librarian

Library

 Object Approach
Decompose by objects or concepts 
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Property 
(Data)
Color
Eye Color 
Height
Length
Weight

Methods 
(Code)
Sitting
Laying 
Shaking
walking 

Property Values
Color - Gray, 
White and Black
Eye Color - Blue 
and Brown 
Height - 18 Inches
Length - 36 Inches
Weight - 30 
Pounds

Methods
Sitting  
Lying
Shaking 
Walking 

TomyDog

Class Object

Create Instance

Procedural Languages Computation involves 
code operating on Data

Code (Methods)

Data (Property)

Object-Oriented Languages
An object encapsulates 
both code and data

Code (Methods)
Data (Property)

Computation involves 
objects interacting with 
each other
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Activity

Consider Car as a class and identify its properties and methods and a 
few objects in that class..

Programming and scripting

Usually, there are hard and fast syntax rules in programming languages. 
These should often be compiled. Programming languages need to be compiled. 
Further, scripting languages should be interpreted. 
Both JavaScript and PHP are scripting languages.

Activity  

Compare the differences between the programming paradigms given 
below.

 • Procedural vs Declarative
 • Structured vs Object oriented
 • Programming vs Scripting

1.5.4  Language translators

Programs written in any computer language except in machine language 
(object code) should be translated to machine language instructions before 
execution. 

A program written in assembly language is translated to machine language 
instructions using a language translator called assembler.

Two types of language translators can be used to translate a program written in a 
high-level language to machine language instructions. They are:

1. Interpreter
2. Compiler
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Interpreter

This is the language translator which translates each statement written in a 
high-level computer language to machine language commands one by one and the 
translated program is executed using the necessary commands instantly.

When translating object codes in computer languages which use interpreters,  

1. If there are no syntax errors in the program, the statement will be executed
2. If there are syntax errors in the program, it will not execute to the end. (it is 

possible to operate it till the error is reached)

Important

An interpreter translates code each time the program is executed.

A program written in 
high level language

Machine language 
instructions

Interpreter

Compiler

Compiler translates the entire program written in a high level language to 
machine language as a whole, before it could be executed.

A program written in 
high level language

Machine language 
instructionsCompiler

When translating source code to machine code in computer languages which 
use compilers:
1. If there are no syntax errors in the program, code is translated to machine code.
2. If there are syntax errors in the program, it is not be translated to machine code. 

These errors are highlighted.

Important
After the program is translated to machine code once, it can be 
execute any number of times. A translation is needed again only if 
the source code is changed.  
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 ² Input, output and the process can be identified by analyzing a problem.
 ² Flowcharts and pseudo codes can be used to develop an algorithm.
 ² Sequence, selection and repetition are three control structures used in an 

algorithm.
 ² Sequence performs steps in an algorithm one after the other from the 

beginning to the end.
 ² Selection is a situation where the step executed should be decided based on 

a condition being fulfilled or not.
 ² If a step or some steps in an algorithm are repeated until a condition is 

satisfied or to maintain the condition being satisfied, it is called repetition.
 ² A name used to identify a variable, constant or a program is called an 

identifier.
 ² If the values assigned for identifiers are changed when the program is being 

executed, these are called variables.
 ² Pascal is a high level programming language.

Summary
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 ² Evaluation of an expression occurs depending on the priority level of 
functions.

 ² Machine language and Assembly language are considered low–level 
programming languages.

 ² Languages like PASCAL, BASIC, C and JAVA are examples of high–level 
programming languages.

 ² A program written using Machine language can be directly run in the 
processor.

 ² A program written in any computer language except in Machine language 
should be translated to Machine language instructions before it runs.

 ² Interpreter and Compiler are two translation programs.
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  After studying this chapter, you will understand the following:

 ² What is a system?
 ² Interactions among components in a system
 ² Manual information systems vs computer based information systems
 ² The ability to determine why a system is necessary
 ² Steps in the development process of an information system 
 ² The use of life cycle models to develop information systems

2.1 The Concept of Information Systems

What is a system?
 

	 A	system	is	a	collection	of	components	that	interact	to	achieve	a	specific	
task.
	 According	to	figure	2.1	below,	the	elements	that	form	the	road	construction	
machine are not interconnected. Therefore, the machine does not function properly 
and	road	construction	is	not	possible.	Figure	2.2	highlights	an	interconnected	road	
construction machine. It is possible to use this machine for construction work in 
order	to	achieve	the	goals.	Figure	2.2	shows	a	machine	working	as	a	system.

     

       Figure	2.1	      The road construction machine       Figure	2.2 

2 System Development Life Cycle
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Basic Elements of a System

A system consists of three basic components.
1.	 Input
2.	 process 
3. output

Input received by a system is converted to output by processing. 

OutputInput Process 

 Figure	2.3	- Basic components of a system

Example 1	-	Consider	the	school	as	a	system.
System	 	 -	 School
Objective	 	 -	 To	produce	a	responsible,	worthwhile,	just	citizens	to
     society
Input	 	 	 -	 Children	
Process	 	 -	 The	child	is	subjected	to	the	teaching/learning	process	
     through interactions of teachers and other resources
Output		 	 -	 Providing	good	citizens	to	the	country

Example 2 
Output tomorrow's weather by a weather forecasting system taking 

atmospheric pressure, temperature, wind direction, humidity as input.

Information Systems

A system which converts data into Information is known as information system. 

Data Process Information

   				Figure	2.4

Information	systems	can	be	classified	as:	Manual	Information	Systems	and	
Computer Based	Information	Systems.			

Manual System 

In this type of a system all processes are done manually.
Example - Let us consider a manual student information system
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	 A	child	admitted	to	a	school	receives	a	registered	number.	A	file	is	prepared	
which	 contains	 personal	 information	 about	 the	 child.	 This	 file	 also	 contains	
information about special abilities displayed while in school and achievements 
recorded.

Assume that the principal requires a progress report on the student of the 
previous year. The input, process and output here are as follows;

Input

Name of student and relevant year

Process

1.	 Find the index number of the student
2.	 Find	the	personal	file	according	to	the	index	number
3. Extract	the	required	information	for	the	relevant	year	from	the	file
4. Prepare a report using this information

Output
Progress report on the student for the relevant year

  Activity  

Assume that the above school has a computer based information system 
instead	of	 the	manual	 system.	Compare	 and	 contrast	 the	 advantages	
and disadvantages when the above information is obtained from the 
manual system and the computer based information system.

Computer Based Information Systems

A system which converts data into Information using a computer is known 
as a computer based information system.
	 Consider	a	computer	based	library	information	system.	Some	of	the	benefits	
to a librarian in using a computer based library system are as follows. 

 ² Ability to detect whether a particular book is available in the library and if 
available, the location of the book. 

 ² Ability to use a bar code to maintain issues and receipts
 ² Ability	to	automatically	calculate	fines	for	late	returns
 ² Ability	to	search	for	books	efficiently	
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 ² Ability to maintain records of those who have borrowed books
 ² Possibility to list those who have failed to return books on due dates
 ² Establishes an online system for remote reservation and searching for books 
 ² Ability	to	provide	e-books	to	members
 ² A	computer	based	library	system	can	be	networked	with	the	main	office	of	the	
school	providing	facility	to	confirm	the	return	of	library	books	by	the	students	
when	issuing	leaving	certificates.	 

  Activity   

List	benefits	of	a	computer	based	library	information	system.

Main differences between manual systems and computer based information 
systems

Computer based information 
systems

Manual systems

Errors are minimal with data 
processed by a computer program

Since the data is manually 
processed, there is more room 
for error.

Data can be processed more 
efficiently

Processing of data is less 
efficient

Large amounts of data can be 
stored in a small physical surface. 
Database software can be used for 
the purpose.

Requires a large space for data 
storage. Filing cabinets are 
required	to	store	files

Security can be ensured with 
backups and the use of passwords

Data is open to a lot of threats.  
Is not as safe as a computer 
based system.

2.2 System Development Processes

To develop an information system, there are different methodologies. The 
System	Development	Life	Cycle	is	one	aspect	of	the	process.
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2.2.1 System Development Life Cycle  

This has the following steps.
1. Identification of requirements
2. Designing the solution
3. Coding  of the solution
4. Testing and debugging
5. Deployment of  the system
6. Maintenance of the system

This process can be iterated to go back to the first step when new requirements 
arise.
Phases of System Development Life Cycle 

 1. Identification of requirements

A complete investigation on the existing manual system or the computer 
based system to be delivered is carried out in this phase. Aspects such as objectives, 
benefits, efficiency etc are constructed. This is carried out in collaboration with the  
staff of the organization and the development team. 

At this stage the system analyst will study the existing system extensively 
and identify new requirements. The developer also collects information to fulfill the 
needs of the user. 
There are several methods of gathering information. Some of them are as follows;

1. Observation
2. Interviews
3. Questionnaires
4. Document sample collection
5. Prototyping

1.  Observation
At the initial stages of developing a computer based system, the existing 

system is observed as it is, to gather information. This is important towards making 
assumptions.
E.g. - Observation of issuing of books in a library
2.   Interviews

Since the interview provides an opportunity to discuss matters related to 
personal attitudes openly, it is useful to identify personal requirements. 
E.g. - Meeting the librarian for a discussion.
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3.   Questionnaires
A  questionnaire is used in user requirement gathering. Answers collected 

are	analyzed	for	understanding	the	needs.		
E.g. - Handing	over	a	questionnaire	to	the	librarian	for	his/her	responses

4.   Document sample collection
	 Reports	or	files	maintained	in	an	organization	under	study	are	examined	for	
information.
E.g. - Reports, library cards available in a library

5.   Prototyping
A model or a prototype of the proposed system to be implemented is 

developed and demonstrated to the staff and the users for feedback and comments.  
E.g. - A display of screenshots, records, samples

 2. Designing the solution

     At this stage, actual design of the proposed system takes 
place. Some activities related to the design process are as 
follows:

1.	 Identification	of	software	and	software	architecture
2.	 User	 interface	 -	what	 the	user	 sees	on	 the	 screen	and	preparation	 for	data	

storage
3. Identification	of	main	hardware	systems	and	its	components
4. Identification	of	dependency	of	each	sub-system
5. Deciding on the required hardware and software to run the system
6. Designing infrastructure for software, databases, user interfaces
7. Planning of tests

 3. Coding  of the solution

        The main objective of this stage is coding 
of the proposed system, using a suitable computer 
language.	 Making	 the	 code	 simple	 and	 efficient	
enables one to develop and understand easily. A 
well-written	 code	 makes	 it	 easy	 to	 read	 and	
understand and reduces maintenance cost.  
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 4. Testing and debugging

 The main objective of this phase is to resolve 
errors. Errors in cording, planning and requirements  
are corrected. 
 There are several methods to test a system.  
Some of them are as follows:

  

Unit testing

Integration testing 

System testing

Acceptance testing

					Figure	2.5	-	System	Testing

1) Unit Testing
      Each unit in the system is tested. Outputs are tested against 
the given output.
E.g. - Testing the units related to the Accounts branch and 
         Establishment branch independently.

2) Integration Testing

    Units already tested and debugged are integrated to form 
the complete system and the integrated system is tested at this 
stage.

3) System Testing

    The complete system is tested for its outputs for the given 
inputs. 
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4) Acceptance Testing

       Acceptance or user acceptance testing is carried out at the 
late stages of testing. This testing is carried out at with the users 
of the system and the user is allowed to use the system. Either 
the user approves or request for more improvements.

  
5. Deployment of the system

   Deployment (ie install and use) of the system which has 
been tested and debugged is carried out at this stage.
    There are different deployment approaches to deploy a 
system. They are as follows:

1.	 Direct deployment
2.	 Parallel deployment
3. Pilot deployment
4. Phased deployment

Direct deployment

    The existing system is totally terminated and the new 
system is installed. If the new system proves successful, the old 
system can be abandoned.

E.g. -   The manual system in the library can be totally abandoned 
    using and new library management software can be 
           installed.

Parallel deployment
 The existing and the new systems are used 
parallel for a certain period. If the new system 
proves successful, the old system can be terminated 
and the new system continues.
E.g. - Using the newly deployed system in the library
          together with the existing manual system.

Pilot deployment
 Pilot deployment is about using the newly 
developed system in a selected area. 
E.g. - A	system	for	 the	whole	country	can	first	be	
 installed in a selected district. 
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E.g. - A	system	for	revenue	collection	from	vehicles	can	first	be	installed	in	one	
           province of the country and if, successful, can be deployed in all provinces 
              of the country.  
Phased deployment

 Here, the new system is deployed in stages. 
Success with each stage leads to the next and in 
completing the new system, the old system is 
completely replaced by the new.   

E.g. -	Types	of	books	in	school	library,	i.e.	Dictionaries	first,	course	books	second	
										and	fiction last,	to	be	deployed	in	stages.	

 
6. Maintenance of the system

 A system once installed and in the use for a 
certain period, needs to be maintained well. The 
computers, software and computer networks are all 
maintained in this manner.
 With system maintenance, the following may 
be required.

 ² Developing systems to suit new user requirements
 ² Issues	that	surfaced	with	the	use	of	the	system	which	were	not	identified	during	

system development. 
 ² Adopting	new,	technology	into	the	new	system	to	improve	efficiency

2.2.2 System Development Life cycle Models  

	 There	are	several	models	of	Systems	Development	Life	Cycle.	Each	model	
facilitates the system development in different ways. Some example models are:

1.	 Waterfall Model
2.	 Iterative Incremental Model
3. Prototyping Model
4. Spiral Model 

Waterfall Model

 The Waterfall Model consists of several stages of linear development. To 
develop a system using the  Waterfall Model, the following need consideration.
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 ² First identify requirements 
 ² Complete	one	stage	before	going	to	the	next	phase
 ² The	result	of	the	developed	system	is	found	at	the	final	stage.	This	model	has	a	

limitation of developing a system that is different to what the user wants as the  
user	sees	the	system	at	the	end	of	the	Life	Cycle.

	Figure	2.6	-	Phased	System	development	model	-	Waterfall	model

Iterative Incremental Model 

Iterative Incremental Model is also used as a system development model.

Identification	of	
requirements

Planning

Initial Planning

Evolution

Testing
Deployment

Implementation

Analysis and Design

    
 Figure	2.7	-	Iterative	Incremental	Model
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 In this model, a system is developed through repeated cycles (Iterative) 
and in smaller portions at a time (incremental). The process starts with a simple 
implementation	of	a	sub-set	of	the	software	requirements	and	iteratively	enhances	
the evolving versions until the complete system is implemented. At each iteration, 
design	modifications	 are	 made	 and	 now	 functional	 capabilities	 are	 added.	 This	
modal allows software developers to take advantage of what was learned during 
development and use of the system.

Activity 

Compare	 and	 contrast	 the	Waterfall	model	with	 iterative	 incremental	
model.

 ² A system is the collection of different components that usually interconnected 
towards a common objective.

 ² Any system consists of  three basic components  namely input, process and 
output.

 ² Information systems transform data into information.
 ² Information systems can be divided into Manual Information Systems and 
Computer based	Information	Systems.

 ² Manual Information Systems does not use computers and performs tasks 
using human.

 ² Computer based	Information	Systems	use	a	computer	to transform	data	into	
information.

 ² A	system	can	be	developed	or	an	existing	system	can	be	made	more	efficient	
by using the system development life cycle.

 ² The system development life cycle consists of the following:
1.	 Identification	of	Requirements
2.	 Designing Solution
3. Coding	of	Solution
4. Testing and Debugging
5. Deployment of System
6. Maintenance of System

 ² The waterfall life cycle model and iterative incremental models are examples 
for system development life cycles.

Summary
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   After studying this chapter, you will be able to understand the following:

 ² Internet operation
 ² Internet services
 ² Searching information
 ² Uniform Resource Locator-URL
 ² IP addresses
 ² Domain name
 ² Domain name server
 ² Protocol
 ² Electronic mail
 ² Video conference
 ² Social networks

3.1.1 Introduction of the Internet

The Internet is a collection of computer 
networks around the world. It is the fastest 
available way to share information with the 
world community (Information super highway). 
With the use of Internet today, the whole world 
has become a global village. The Internet, which 
renders such a big service, does not possess a 
single owner and a non profitable organization called "The Internet Society" is 
in charge of the ethics and principles related to the use of the Internet and the 
protocols which maintain Internet operations. When you access the Internet from 
your computer, it also becomes a computer which belongs to the Internet. Then it is 
possible for you to obtain any information related to any subject you need.

3  The Internet and the electronic mail

   After studying this chapter, you will be able to understand the following:

² Internet operation
² Internet services
² Searching information
² Uniform Resource Locator-URL
² IP addresses
² Domain name
² Domain name server
² Protocol
² Electronic mail
² Video conference
² Social networks

   After studying this chapter, you will be able to understand the following:   After studying this chapter, you will be able to understand the following:
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3.1.2 Let us examine what URL is

Information which helps us to improve our knowledge is a very important 
resource. Among the avenues of obtaining information, the Internet is the most 
powerful. To transmit this information among the computers in the Internet, the 
protocol called HTTP (Hypertext Transfer Protocol) is used. Further, the Internet 
contains a huge amount of information. The main service which provides this 
information is the World Wide Web (www). Therefore, the information in the World 
Wide Web is included in web sites. Thus, the system used to uniquely identify 
various resources in web sites is the Uniform Resource Locator (URL).

Let us identify parts of a URL

For example, let us consider the URL given below.

http://www.edupub.gov.lk/e-books/english/ict.pdf

We can separate the parts here as given below.

http://www.edupub.gov.lk/e-books/english/ict.pdf

hypertext transfer
protocol

World Wide Web path where the  
resource is located

domain name resource

↓

↓ ↓ ↓

Figure 3.1 - Uniform Resource Locator

Note: In a Uniform Resource Locator, it is a must to have, from HTTP protocol to 
Domain name.

Given below are some URL related to the field of Education.
http://www.moe.gov.lk  - Ministry of Education 
http://www.nie.lk   - National Institute of Education
http://www.doenets.lk   - Department of Examinations
http://www.edupub.gov.lk  - Educational Publications Department
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3.1.3 what is an IP address?

Internet Protocol (IP) addresses are used to individually identify all the 
computers in the Internet. The IP address is indicated in four values from 0 to 255 
separated by a decimal point. This is called Dotted Decimal Notation.

Example   172.64.85.42
  193.213.78.154

  Figure 3.2 - Using IP addresses to identify computer in the Internet

These IP addresses are assigned by an Internet Service Provider (ISP). An 
Internet Service Provider (ISP) is a company and it provides access to Internet. For 
this, the ISP charges a fee for the service.

3.1.4  what is a domain name?

Let us consider the domain name  
edupub.gov.lk of the Uniform Resource Locator 
given above. Here gov represents the government 
and lk represents Sri Lanka. Thus, lk domain which 
comes after gov domain is the top level domain name. 
Domain name gives an identity to all the websites 
which exist in the Internet. 

Following are the names used to represent the fields which the domains 
belong to.

 Domain              Meaning
com Commercial
org Non profitable organizations
gov Public

         edu Education
net Web
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The following country domains are used to represent the country related to 
the domain.

 Domain  Meaning
in India
au Australia
jp       Japan
uk United Kingdom
us United States

The domain at the right - most corner of a domain name is called the Top 
Level Domain.                               

Example

URL Domain Name Top Level Domain
http://www.google.com google.com com
http://www.edupub.gov.lk edupub.gov.lk lk
http://www.nie.lk/pages/syllabus.asp nie.lk lk
http://www.unicode.org/consortium/
consort.html

unicode.org org

3.1.5 How the Internet works
 

Humans, being different from computers, have difficulty in retaining lots 
of similar numbers in mind. Working with names is much easier for them and 
cause less errors. That is why we rarely see the numbers as URLs on the Internet. 
When a URL is entered to the browser to view a website, the request must first be 
translated from the readable written address into an IP address that can be routed. 
This translation is done by the Domain Name System (DNS).

If a request is made to connect to certain website, for example www.yahoo.
com, the request is first sent to the DNS server to translate into the correct IP 
address of 209.191.122.70. The actual connection to the website is done with this 
IP address. This process happens behind the screen quickly that the user does not 
notice. 
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Web 
server

DNS 
server

OS

1 User opens browser, 
enters URL...

Resolver

6 Web browser 
renders HTML web 

page
5 Web server returns 

HTML data stream

4 Browser 
sends 

''http get'' 
command to 
web server

3 Browser now 
has IP

2

  Figure 3.3 - Process how Internet operations are executed

The Internet, which does not possess any owner, is controlled by protocols. A 
protocol can be seen on a system of law operated in computer networks. Following 
are some protocols used in the Internet.
HTTP - Hypertext Transfer Protocol
TCP/IP - Transmission Control Protocol / Internet Protocol 
FTP - File Transfer Protocol
SMTP - Simple Mail Transfer Protocol
ICMP - Internet Control Message Protocol

Protocol Usage
HTTP HTML document exchange
TCP/IP Controlling the exchange of IP addresses

FTP File exchange
SMTP Electronic mail exchange
ICMP Informing and controlling messages when there are errors
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  The Internet is a Wide Area Network (WAN) which is based on a Client 
Server Model. Hence, all the computers in Internet belong either to the type of 
servers or clients.

Figure 3.4 - Client server architecture in the Internet

The computer that distributes the resources required by the client computer 
is called the "server". 

The activity of retrieving information from the server computers to 
client computers is called "downloading".

The activity of providing information from client computers to 
server computers is called "uploading".

Hence, transfer of information between server and client computers is 
two-way.

Let us identify some Internet server computers.

Web Server - Storing web pages and providing these to the client computers
Mail Server - Storing electronic mail and providing them to the client computers
DNS Server - translating URL to IP addresses

3.1.6 Services of the Internet

The following are some of the services of the Internet;

1. World Wide Web - WWW
2. File Transfer Protocol
3. Remote Access
4. File Sharing
5. Streaming of media
6. Search Engines
7. Electronic Mail - e mail
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3.1.6.1  World Wide Web (WWW)

World Wide Web is a service provided by 
the Internet and it is a large collection of electronic 
documents saved in computers all around the 
world connected to the Internet.

Sir Tim Berners Lee is considered the 
father of www. A user who uses www can access 
web sites through a Web Browser. 

A Web Browser is an application software. 
Following are some examples of Web Browsers.

Figure 3.5 - Web Browsers

A web site consists of several web pages. 
There can be written text, images, videos and 
other multimedia and hyperlinks included in a web 
page. Use of hyperlinks makes browsing the web 
sites easy. To access a web site, Uniform Resource 
Locator – URL (web site address) should be typed 
on the address bar of the web browser and the 
‘Enter’ key pressed. The page which contains 
the basic information about the web site is called 
the ‘Home Page’. The other pages of the web site can be accessed through the 
hyperlinks included in it. 

For instance, let us consider the official web site of the Department of Examinations, 
Sri Lanka.

Address 
bar

Hyperlinks

 

Home 
page

Figure 3.6 - Home page of the website of Department of Examinations, Sri Lanka 
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3.1.6.2 File Transfer Protocol (FTP)

File of smaller size can be sent with an e mail 
as an attachment. But files with larger capacities cannot 
be sent in an e mail attachments.

FTP is used to transfer large files of one 
computer in the Internet to another computer. This 
protocol is operated on TCP/IP and used to upload files of a client computer to the 
Internet and to download files from server computers in the Internet.

Figure 3.7 - File transfer system

3.1.6.3 Remote Access

Figure 3.8 - Remote access

 
 
 
  
    

Controlling and operating a computer in the Internet remotely is performed 
through remote access. Following are certain functions which can be performed 
through Remote Access after accessing the Internet.
1. Installing software of server computers to client computers.
2. Fixing problems on client computers.
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Using remote access functionality sometimes hackers steal important data 
and information stored on computers without owner's knowledge (This is called 
hacking).

3.1.6.4 File Sharing
 

The main objective of computer networking is 
to share resources. Such resource sharing includes file 
sharing. Thus, sharing of various files in the Internet take 
place often.
Example
1. When you check exam results on line, that file is accessed by a large number of 

clients at the same time.
2. Thousands of users can be connected to a web site at the same time.

3.1.6.5 Streaming of Media

A user visits a Web 
page hosted on a Web 
server and finds a file 
he'd like to see or hear.

 

The Web server sends 
a message to streaming 
media Server, requesting 
the specific file.

The streaming 
server streams the 
file to the user's 
computer, bypassing 
the Web server 

Basic Streaming Process

4 The client software on the user's 
computer decodes and plays the file

Media Server

   
   
 

               Figure 3.9 - Streaming of media    
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  Internet provides much assistance to share all sorts of information which 
consists of multimedia such as text, images audio and video. Downloading images, 
songs and videos etc from the Internet can be considered as an example.

3.1.6.6 Search Engines

 Web sites largely contain information on the 
Internet. These websites should obtain information. 
For this, you should know the address (URL) of the 
web site. However, the unlimited number of websites 
in the Internet makes it practically very difficult. 

 Search engines are designed for the Internet 
users to find any information easily.

 After typing the key words in the search box of the search engine and 
clicking the search button, you will get a large number of web sites with hyperlinks 
which contain the information you need. You can obtain the necessary information 
by clicking one or several hyperlinks. 

Given below are some examples of search engines used often.
http://www.google.com or http://www.google.lk 
http://www.yahoo.com
http://www.ask.com
http://www.msn.com

3.1.7 Domain Name Server

Figure 3.10 -  Domain names are converted to IP address by domain server

  Domain name is used to uniquely identify a web site. This makes the users 
remember it somewhat easily. However, an IP address is used to uniquely identify 
a computer on the Internet. What the Domain Name Server does is converting the 
domain name to an IP address.



For free distribution74 For free distribution 75

3.2  Using Internet for communication

3.2.1 Electronic Mail

   Electronic mail enables exchanging messages as electronic mails or files 
between two or more people. There are several organizations which provide e mail 
service free of charge through the Internet. Hence, the cost is only for the use of the 
Internet. This is the cheapest and fastest communication method in the world.

Sending 
Mail Internet 

Receiving 
Mail

Mail Server Mail Server

Personal 
computer

Figure 3.11 - Exchange of e mails in the Internet
   
   Any person in the world can create an electronic mail account through the 
Internet and this can be used to identity this person within the Internet. 
An electronic mail address takes the form as follows.
   Let us consider the email address of the Department of Examinations, Sri 
Lanka for instance.

exams@doenets.lk

User name Domain name

↓ ↓

   Here, exams is the user name and doenets.lk is the domain name. @ symbol 
separates the user name and the domain name.

It is essential for the sender as well the receiver to have email accounts.
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   An electronic mail account should be created 
before using an electronic mail. The web sites which 
provide electronic mail services on the Internet provide 
facilities free of charge. It is essential for an electronic 
mail (e mail) account to have an email address and a 
password. The email account should be opened to send 
mails or to check the received mails. User name and 
password should be entered accurately for this and then 
click 'Sign In'.

Sending an email

Sending an e mail can be performed in the following manner.

Dear All,

Please see attachment for my results.

Shani

Subject OL results released

To sasikala7@gmail.com
Cc bpdasun@yahoo.com
Bcc monali@sltnet.lk

Attachment

Figure 3.12 - sending an e mail

 ² Type the receiver’s email address in To (sasikala7@gmail.com)

 ² Type the email address of the others 
(bpdasun@yahoo.com) who should 
receive the copies of the email in Cc 
(Carbon copy)

 ² Type the email addresses of those who 
should receive the mail without the 
awareness of those receivers typed 
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under To and Cc in Bcc (Blind carbon copy). Those who receive Bcc copies 
can view all the receivers of the mail. However, the receivers typed under To 
and Cc cannot view the receivers of Bcc copies (monali@sltnet.lk)

 ² The person who receives Bcc copy (monali@sltnet.lk), can see all the e mail 
addresses (sasikala7@gmail.com) and (bpdasun@yahoo.com) that this letter 
sent. Persons under To and Cc (sasikala7@gmail.com) and (bpdasun@yahoo.
com) cannot see the e mail address of Bcc

 ² Type the title or relevant subject related to the mail in Subject. (O/L results 
released)

 ² Attach other file or files which should be sent with the e mail by clicking the 
attachment button with the paper clip icon. (Results.jpg)

 ² Send the email by clicking "Send".

e mails are categorized inside an e mail account for easy use.
 ² Inbox - To store mails received
 ² Drafts - To store mails that are composed to be sent but could not be 

completed 
 ² Sent - To store mails sent
 ² Trash/Deleted - To store mails for a certain period that are deleted 
 ² Spam/Junk - To store mails that are unwanted  

Unwanted e mails stored in a separate folder without disturbing the Inbox 
are known as Spam. 

  

Inbox Spam
  

                      Figure 3.13 -  Spam mail      
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3.2.2  Sending instant messages - IM

Member Fax

Member Computer

Member Phone

Member 
Message

Voice

Public 
Computer Fax

  

            Figure 3.14 - Sending instant messages 
      

Figure 3.15 - Tools for sending instant messages

Two persons can 
exchange short messages very 
fast (chat) over the Internet 
using the chat facility. 

3.2.3 Video conference

Video conferencing is conducting a 
conversation between two or more persons in 
different (remote) locations using audio and 
video transmission over computer networks. 
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The requirements are as follows for a video conference
 ² Computers
 ² Web cam
 ² Internet connection
 ² Communication software (with audiovisual facilities)

3.2.4 Social Networks

Social networks are, used to maintain social 
relationships over the Internet.

These social networks facilitate the people to 
exchange personal details, photographs, videos and daily 
activities. As a result, social relationships are widened and 
also can create social issues. 

Given below are some examples of social networks.

http://www.facebook.com
http://www.twitter.com
http://www.youtube.com
http://www.flickr.com
http://www.pinterest.com
http://www.secondlife.com

3.3 Cloud Computing
 

Cloud computing is the practice of using a network 
of remote servers hosted on the Internet to store, manage 
and process data, rather than a local server or a personal 
computer. The main services of cloud computing are

 ² Infrastructure as a Service (IaaS)
 ² Platform as a Service (PaaS)
 ² Software as a Service (SaaS)
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Infrastructure as a Service (IaaS)
This provides a virtual environment of servers to provide space to store data 

and software applications with the help of server computers and also to provide 
various resources through the use of large data centres established.
E.g. - Obtain the facilities of server space and firewall through cloud computing 
            even though you do not own them

Platform as a Service (PaaS)
This platform provides necessary server environment for software 

development. This gives facilities including operating system, programming 
language environment, database and web server.
E.g. -  Software can be developed in the cloud computer service even though you do
           not have installed operating system or compilers in your computer.

Software as a Service (SaaS)
This provides software installed in cloud without installing the software 

required by the user.
This reduces the cost and complexity of buying and managing hardware and 

developing software needed for software by the user.
E.g. - In Android devices, word processing software, spreadsheet packages etc that 
           can be used not by installing them in the device but using a web browser. 

 ² Lower software cost
 ² Improve performance
 ² Fewer maintenance issues
 ² Instant software updates

 ² Requires a constant Internet connections
 ² Does not work well in low speed 

Internet connections

Advantages 

Disadvantages

Advantages and Disadvantages
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Activity   

1' Match A and B columns

 A column B column
e mail address doenets.lk
Domain name 172.92.83.106
Uniform Resource Locator somasiri@gmail.com
IP address http://www.nie.lk/syallabus/ol/ict.pdf

A column B column
Web address Converts domain name into IP addresses
A service in the Internet Google
Domain name Mozilla Firefox
Search engine World wide web

 ² Uniform Resource Locator (URL) helps identify resources available in the 
web sites uniquely. 

 ² IP addresses help identify every computer in the Internet uniquely.
 ² To identify a web site, the domain name is used.
 ² Domain name server transforms the domain name into an IP address.
 ² All connections on the Internet are performed using protocols.
 ² World Wide Web and e mail are some of the main services provided by the 

Internet.
 ² To view the web pages, web browsers are used.
 ² Search engines are used to find information in the web.
 ² e mail is the fastest and the cheapest method of communication.
 ² an e mail address is unique.
 ² Instant messages, video conferencing and social media are also used in 

communication.  

Summary
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   After studying this chapter, you will understand the following:
 ² The basics of digital graphics
 ² Graphic size and compression
 ² Graphic types
 ² Basics related to graphic design 
 ² Fundamentals of animation
 ² Geometric objects and shapes
 ² Types of frames
 ² Multimedia animation
 ² Multimedia distribution
 ² Audio recording
 ² Multimedia editing
 ² Audio/Video mixing towards animation

4.1  Digital Graphics
 
 From times immemorial man practiced the art of drawing and colouring 
to portray a beautiful idea, or a visual that left a lasting impression. Ancient wall 
paintings remind us about the important role played by artistry in conveying ideas. 
Pictures formed the basis of communication. At the same time, available pictures 
make us realize the difficulties our ancestors would have faced to convert an idea 
into an illustration. There would have been many drawbacks in mixing of colours. 
Yet, they overcame such drawbacks to leave behind the paintings seen today. 
 However, with the development of technology and the availability of software 
for digital graphics, it is now possible to create various graphical illustrations and 
edit them. Using such software for graphics is quite simple and interesting.
 Drawings or images, created with the use of computer graphic software, are 
called digital graphics.

4 Use of Multimedia       
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Let us identify the fundementals of digital graphics (fig. 4.1).

Pixel

Resolution Size

Colour

Basic 
elements 
of digital 
graphics

Figure 4.1 - Basic elements of digital graphics

 ² Pixel

A pixel is a tiny illuminated dot having a colour which is displayed on a 
computer screen. The digital graphics are created with thousands of such pixels.  

These pixels get arranged in rows or columns close to each other to produce 
graphical image (fig. 4.2). A digital graphic is an array of rectangular pixels called 
a bitmap.

Pixel 

Pixel array

Pixel row

Pixel column Magnified image

Fig 4.2 - Pixel

The size of a graphic can be increased or decreased to fit into a computer 
screen or a printing paper. In changing the size of the original graphic, the size of 
the pixel is changed. When the graphic has a smaller number of pixels its quality 
decreases when  it is enlarged (fig 4.3). 



For free distribution82 For free distribution 83

Fig 4.3 - Decrease in quality in an enlarged graphic

Colours used in a graphic are represented by the number of bits per pixel 
(bpp) used. Graphics which use more bits per pixel are higher quality.

 ² Colours in a pixel and the number of bits

The number of bits per pixel determines the colours used in an image.

A single bit represents two colours Two bits represent four colours

two colours0 }1 four colours
00  01  10
11    
}

However, by observing a graphic, it is not possible to determine the numbers 
of colours per pixel used. The number of bits used for the pixel only help find out 
the number of colours per pixel used. The following function can be used for the 
purpose.

Colour per pixel used = (2) bpp ^bits per pixel&

E.g. - If a pixel has 4 bits,

Colour used on the pixel = ^2&4

    = 2 × 2 × 2 × 2
    = 16 colours
To find the number of bits when the colours are known:
The number bits per pixel = √colour    

    = √16
The number of bits per pixel  =  4
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     1 bit    4 bit     8 bit     24 bit 

 Bits per Pixel function Number of colours
1 bpp (2)1 2
2 bpp (2)2 4
3 bpp (2)3 8
4 bpp (2)4 16
5 bpp (2)5 32
6 bpp (2)6 64
7 bpp (2)7 128
8 bpp (2)8 256
10 bpp (2)10 1024
16 bpp (2)16 65536
24 bpp (2)24 16777216

(16.7 million colours)
32 bpp (2)32 4294967296 colour  (4294 

million colours)

 ² Resolution

1
7
5

P
i
x
e
l

250 Pixels
(43,750 Pixels)

Fig 4.4 - Image Resolution

 Pixels are used to measure the physical 
dimension of a digital graphic. The physical 
dimension is displayed as the image resolution.   
 This illustration in Figure 4.4 is 250 pixels 
wide and 175 pixels high. The image resolution, 
therefore, is 250 x 75 pixels or 43,750 pixels.
 A high resolution digital graphic using a large 
number of pixels is higher in quality. To determine 
the quality of a graphic the number of pixels per 

inch (ppi) used (horizontal or vertical) or the number of dots per inch (dpi) used 
(horizontal or vertical) are considered. (Figure 4.5)
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Fig. 4.5 - Number of dots per inch (dpi)

 ² Colour  

 A digital graphic contains tens of thousands of pixels. Each pixel represents 
a colour. Therefore, a pixel is a small dot with a colour.
 There are about 16 million of recognizable colours visible to the naked eye.  
This number comes from a mixture of colours. However, it is difficult to correctly 
recognize each colour. (figure 4.6)

Ultra Violet  InfraredColours visible to the 
naked eye        

Fig 4.6 - Colours visible to the naked eye

 In designing digital graphics it is possible to use many colours. The colour 
model which should be used for the design must be decided based on the output 
device or the media. (figure 4.7)

Two widely used colour models are shown on figure 4.7

CMYK Model

Color Models

RGB Model

Fig 4.7 - Colour Models

 ² RGB Model – This is widely used to create images on television screens or 
computer screens using coloured lights. The Primary Colours used here are 
Red, Green and Blue.

 ² CMYK Model – This model is used for printing on paper using coloured inks. 
The Primary Colours used here are Cyan, Magenta, Yellow and Black.
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A mix of RGB gives out secondary 
colours

Mix of CMYK inks gives out RGB

Fig 4.8 - Mixing colours

Colours are very useful to maintain the quality of the picture or illustration. 
Single colours are known as primary colours. Colours made by mixing two colours 
are known as secondary colours while tertiary colours are made by mixing three 
colours. There are 256 (0 - 255) colour variations in a primary colour. 

Forming a tertiary colour

To make a tertiary colour, the colour combination should be from 000, 000, 
000 to 255, 255, 255. This is known as RGB Triplet and it can be represented in 
octal numbers as RGB (245, 102, 36) or RGB (F5, 66, 24). (Figure 4.9)

Basic 
colours

Fig 4.9 - tertiary colour mixture
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Graphic size and compression

The size of a graphic is determined by the number of pixels, the number 
of lines and the colour combinations used for the creation. A graphic with a large 
number of pixels, colours and a high resolution has a large file size. There may be 
difficulties in storing and transmission of such a graphic. Graphic compression is 
used to compress file size. Compression can be carried out at the time of saving the 
graphic or later.

The file formats used for compression in saving a graphic may or may not 
cause affect to the original quality of the graphic. The file formats are created using 
different algorithms to suit the compression.

There are two methods for graphic compression - Lossy compression and 
Lossless compression. (Figure 4.10)   

Lossy compression    Lossless compression

Original graphic

compressed 
graphic

The opened 
graphic

Does not open in its original 
form 

Uses lossy 
compression

Opens 
graphic

Original graphic

Uses lossless 
compression

Compressed 
graphic

The opened 
graphic

Opens in its original form

Opens 
graphic

Fig 4.10 - Use of Compression methods

It is possible to compress graphics to a minimum size using Lossy file 
formats, but this compression reduce the quality of the original graphic. The 
reopened graphic does not show its original form. Yet, to make it faster for 
compression and for saving and downloading from the Internet, Lossy compression 
is useful. JPEG, TIFF, BMP are a example for Lossy file formats. 

On the other hand, it is possible to compress a graphic preserving its 
original quality. In opening such a file, it is displayed in its original quality. This 
compression is identified as Lossless format. GIF, PNG, RAW are examples for 
Lossless file formats.
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Graphic Types

Digital graphics fall into two main categories. They are raster graphics and 
vector graphics. The type of graphic (raster or vector) is decided according to the 
graphical software used.  
There is a difference between Raster graphic and Vector graphic. Let us 
identify them.

Criteria Raster graphic Vector graphic
Creation of the 
graphic

Array of pixels in different 
colours

By collection of straight or curved 
lines 

File records No records Maintains a record of the start and 
the end, number of lines, straight 
and curved lines and colours used

Quality of the graphic Quality is lost when the size 
changes

Quality is not lost when the size 
changes

For high quality 
creations 

Not suitable Suitable 

Creation and saving Uses less memory space Needs more memory space
Computer speed in 
creation

Does not change Reduces

Examples of software Adobe Image Ready, Adobe 
Photoshop,  ProArtRage, 
Artweaver, Corel PHOTO-
PAINT, GIMP, Deluxe Paint, 
GIMP shop, Microsoft Photo 
Editor

Adobe Illustrator, Adobe Live 
Motion, Corel Paint Shop Pro, 
Adobe Fireworks, Microsoft 
Expression Design, DrawPlus, X 
ara Photo & Graphic Designer, 
CorelDRAW, Litha-Paint

Created using Raster graphic and 
enlarged

Created using Vector graphic and  
          enlarged 

Graphic to be created

Figure 4.11 - Difference between raster graphics and vector graphics
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Graphic Design

There are many software types for the creation of static graphics. A few of 
them were mentioned earlier. Most of such software need to be purchased while 
some may not be compatible for all Operating Systems. Therefore, let us see a 
software that comes free and can be downloaded from the Internet.

GIMP

GIMP is an image manipulation program created for GNU free and 
open source operating system. This free software is widely used to reconstruct 
photographs, create graphics, edit and formatting of graphics. This software with 
many tools helps with the creation a simple graphic as well as to edit a high quality 
photographs. GIMP software belongs produces raster graphics.

GIMP software is UNIX based. It can also be installed on Microsoft 
Windows and Mac Operating system to install GIMP on a computer, go to http://
www.gimp.org/downloads/.

GIMP  - Graphical User Interface

1 3 4

2

5
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      1. The Main Toolbox    4. Layers, Channels, Paths
5. Brushes/Patterns/Gradients2. Tool Options

3. Image Window

1. The Main Toolbox
It is possible to open or close the tools in this box for the editing graphics.

For the purpose, follow:
Edit → Preferences →Toolbox →
The tools can be enabled or disabled.

Icon Name of the 
tool

Shortcut Description

Selection tools
   Rectangle   R Selects the required area as a square 

or rectangular region.

   Ellipse  E Selects the required area as a 
circular or elliptical region.

   Free (Lasso)  F Draws free-form selections

Fuzzy (Magic 
Wand)

U Selects areas on color similarity.

By Colour Shift + O Selects all instances of a colour in 
a graphic.

Scissors I Creates paths to select shapes

Foreground - Selects a region containing 
foreground objects.

  Brush Tools
Bucket Fill Shift + B Fills an area with a colour or a 

pattern.
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Blend 
(Gradient)

L fills the selected area with a 
gradient blend

Pencil N Paints hard-edged lines; that is, the 
pixels are not anti-aliased.

Paintbrush P Paints soft-or fuzzy-edged lines; 
that is, the pixels are anti-aliased 
and/or feathered.

Eraser Shift + E Erases pixels from a layer.

Airbrush A Paint tool with variable pressure to 
spray colours on a graphic

Ink K Adds colour to a graphic, like the 
paintbrush.  Quick movement of 
mouse minimizes the size of brush.  
Slow movement makes its vice 
versa

Clone C Copy pixels from one part of a 
graphic to another.

Heal H Resolves image irregularities 
removing unnecessary colours and 
spots

Perspective 
Clone

- Clones from an image source 
after applying perspective 
transformation.

Convolve 
(Blur/Sharpen)

Shift + U Blurs or sharpens an image

Smudge S Dampens graphic

Dodge/Burn Shift + D Lightens or darkens an image's 
shadows, mid tones, or highlights.
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Transform Tools
Move M To shift or move a selection

Align Q To align or arrange layers or objects

Crop Shift + C Crops or clips the image

Rotate Shift + R Rotates the active layer, selection 
or path.

Scale Shift + T Scales the active layer, selection or 
path

Shear Shift + S Shifts part of the image in some 
direction.

Perspective Shift + P Changes the perspective of the 
active layer, selection or path

Other Tools
Path B Allows selecting and modifying 

paths

Colour Picker O Selects the colour of any image 
opened on your screen.

Magnify 
(Zoom)

Z Alters the zoom level of the image

Measure Shift + M Shows distances and angles

A Text M Places text into the image.
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2. Tool Options:  The Tool Options are available to customize the options for a 
tool.  

3. Image Window: Helps display the graphic created.  It is possible to keep 
several windows open to suit selection.  In this situation several windows will 
be open at the same time.  Or else one window can be kept open and use others 
as necessary.  For this purpose, select:

  Windows → Single-Window Mode 
4. Layers, Channels, Paths: These are shown as Tabs and can be clicked open 

when necessary.
5. Brushes/Patterns/Gradients: These tabs help create and add colour to a 

graphic.   

Basics of a Graphic software

Opening a new 
window for a 

graphic

 ² Click 'File' → 'New' 
      The  'New Image' dialogue box opens.
 ² Select the size of the graphic
 ² Either adjust height and width or select 

a template
 ² Click 'OK'

To save a graphic 
created

 ² Click 'File' → 'Save'
 ² Give name to the graphic in 'Save 

Image' dialogue box
 ² Select a saving location from 'Places'
 ² Click, 'Save'

Note: Graphics Created in GIMP are 
saved in XCF (file extension)
(Eg: image 1.xcf)

Export Graphic

 ² Select File → Export
 ² Give a Name for the graphic in 'Image' 

dialogue box
 ² Select suitable saving Location from 

'Places'
 ² Select File Formats from 'Select File 

Type (By Extension)'
 ² Click, Export

(Compression takes place to suit different 
file types)



For free distribution94 For free distribution 95

Opening an existing 
window

 ² Click 'File' → 'Open'
 ² From the dialogue box 'Open', 

select saving location from 'Places'
 ² Select the saved graphic from, 

'Names' window.
 ² Click 'Open'

Using GIMP software

1. Creating a graphic using several pictures

 ² The following methods can be used to obtain images for graphic creation.
 ² scanned pictures saved in the computer
 ² Images captured on a digital camera saved in the computer 
 ² Images captured on a digital camera in a smart phone and saved in the computer.

The above graphic shows a creation with three different images. It is created 
as follows:

You may use images stored in the computer or select an image that can be 
obtained easily.

Step 1 - Open GIMP software

Step 2 - From the Menu, select 'Windows' → 'Single - Window Mode'
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Note: GIMP software contains two window types for use.  One is Single-Window 
Mode and the other, Multi Windows Mode.  The window has to be changed before 
the graphic is created.

To obtain images, 
Step 3 -  Click 'File' → 'Open' and from the dialogue box and open pictures 
  for work. Pictures need to be opened one at a time. Therefore, do
  not select ‘Open as Layers’.

Step 4 - From the Tool Options, select foreground and background as black 
  and white. For this, follow the illustration and click on the colour in the 
  colour box. Or else, with HTML notation, use 000000 for black 
  and ffffff for white using the keyboard. Click 'OK'.

Foreground

Background

Step 5 -  To open a window for a graphic, click on 'File' → 'New'. In the 
   'Create A New Image' dialogue box, indicate width as 1200 and
   height as 800 px and click 'OK'. (Templates can be used for other 
   scales.)

Adjust width and 
height

To get a template

To select 
dimension of 

a template
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Once adjusted, it opens a GIMP Interface as follows.

images
opened New graphic 

Interface

Step 6 - Select the first image. Right click on the related Layers. Select 
  'Add an Alpha Channel'.

The Alpha Channel helps make the picture transparent. With the second picture, 
this transparency comes in automatically. However, when there is only one picture 
in the Layer window, it is necessary to select ‘Add an Alpha Channel.

Step 7 -  Select ‘Ellipse’ from Tool  
  Option. Click ‘Tool Options  
  → Feathers’ and mark the   
  ellipse on selected picture.  

Step 8 - 'Select → Feathers' 
  Make 'Feather' to 10 
  pixels Click 'OK'  
  Select 'Edit → Copy  
  Visible'
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Step 9 -  Click on new graphic window 
  Select, 'Edit' → 'Paste as' → 'New Layer'
  The prepared section of the image appears on the new graphic 
  window.
  Using Move Tool, to position the image on the window.

Step 10 - It is suitable to have all  
  images in the same size.  
  For this, select 'Scale' tool  
  from Tool Options. 
  Click on image 
  In the Scale dialogue box, 
  arrange the width and 
  height of the image as  
  450, 600 pixels. Click, Scale. 

Step 11 - Follow steps 5, 6, 7, 8, 9, 10 and 11 to bring the other two pictures 
  too to the graphic window. Position them and scale.
  

 
      The positioning of layers is shown in this 
manner.
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Layers

 The use of Layers is important for both simple and complex 
graphic creations. It is easy to manipulate objects on a graphic by using 
different layers.
  Layers resemble sheets of transparent paper. However, when 
objects are added one above the other, the layer beneath may not be 
shown.  
 ² For, different pictures, different layers are to be created on layer 

window.
 ² For each image a separate layer must be used on the layer window.
 ² This prevents alterations done on one layer affecting another layer. 

(adding texts, adding colour, shapes, editing etc).
 ² Use the eye symbol to make the layer visible or invisible.
 ² Use the bottom line of layer window to make various alterations.

1 3 5

2 4 6

Opacity
1. New 
2. Group
3. Move
4. Duplicate layers
5. Anchor
6. Delete

 ² Opacity - Can be seen high above 
the Layer window. By increasing or 
decreasing the opacity of a selected layer, 
the visibility of the layers below can be 
altered.
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Opacity 100%

Opacity 75%

Opacity 50%

Step 12 -  Once, editing and positioning are completed, it is necessary to 
  merge all layer together into one layer.  For this purpose, Right 
  click on Layer window and click, 'Merge Visible Layers' → 
  'Expand as necessary' → 'Merge' 

Step 13 -  Use 'Crop' tool to remove unnecessary sections in graphics created. 

Step 14 -  To add a border to a graphic,  
  Select:   
  'Filter' → 'Decor' → 'Add 
  Border'.
  Set Border X – 10, Border Y  
  – 10, Border colour blue →  
  'OK' 
  Border X – 15, Border  
  Y – 15, Border colour  
  yellow → 'OK'
  Borders need to be created twice as shown above.

Step 15 - Save graphic. Thereafter, Export it.



For free distribution100 For free distribution 101

2. Creating graphics with texts

Step 1 -  Open GIMP software

Step 2 - To open a new graphic window, 
  click 'File' → 'New' In the  
  dialogue box select 'Create a 
  New Image', set width - 640,  
  height - 400 px and click 'OK'.

Step 3 - For foreground and background colour,  
  change HTML notation value 29c89c, 
  e3216a to select the colours.
  Next, select Gradient tool.

Step 4 - Click to draw a line on background  
  window from left corner to right corner.  
  The background gets coloured with 
  selected colours. 

Step 5 -  To add text:    
  Select 'Text' from Tool Options. Tool  
  Option changes accordingly. Follow  
  procedure given below to suit the text. 

 ² Font type - Gill Sans Ultra Bold or 
a broad letter type

 ² Font size  - 72
 ² Colour - Black

Click on window and type NATURE. Using 
'Move' tool, drag text to the center.
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Step 6 - To include a border around the text, select the layer which contains  
  the text and add another layer below this. Name the new Layer, as   
  'Text Border'. Using arrows, shift 'Text Border' downwards from   
  text Layer.  

Step 7 - Select text Layer. right click and select 'Alpha to Selection'

Step 8 - To increase the selected  
  area :    
  Select → Grow 
  Increase  
  'Grow Selection' to 2 
  pixels and click 'OK'.

Step 9 -  Select Text Border Layer
  Select white as Foreground colour and to fill colour, select Bucket  
  fill and click on the text.
  Next, 'Select → None'.

Step 10 - To Add Shadow to text 
  Select 'Text Border' layer  
  From the Menu, select:
     'Filters' → 'Light and  
  Shadow' → 'Drop  
  Shadow'.
     Set the values as shown in  
  figure. Click 'OK'.
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Step 11 - Once, it is placed it needs to merge all layers together.
  Right click on Layer window and click:
  'Merge Visible Layers' → 'Expand as necessary' → 'Merge'.

Step 12 - Add a border to the graphic as you learnt earlier. Save in the correct
  place. Export the graphic.  

Note: It is possible to use different colours and different patterns for the background  
of a graphic. Select a pattern. Click mouse on selection → Drag and drop on the 
background.
Use different pictures and create few backgrounds.

Examples:

         

  

  Activity

1. Create a graphic using several photographs you have captured on a 
special occasions or found on the computer.

2. Using other 'Filter' methods used in graphic designing, produce a 
better finish to the graphic you created.

3. Download images of places of special interest in Sri Lanka from 
the Internet. Create graphics using the images downloaded.  Give 
suitable titles or introductions to them.

4. Create an invitation for digital printing.
5. Create a banner for a special event held in the school.

4.2  Two - dimensional animation

The previous lesson discussed several areas connected with the creation of 
digital graphics as related to digital creations and graphic design.

The main aim of animation is to give more depth to a static graphic and 
make it look real or authentic.
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Creative animations are used in commercial publications, as a media to 
promote products, to develop computer games and creating cartoon films.

What is animation?

Animation is an optical illusion to show the movements of an object or 
objects. A series of frames of an object or objects are arranged in a sequential order 
and displayed continuously to create the animation. The speeds of the objects can 
be changed by changing the speed of frames.

Basics of animation

Types of Frames
Several frames are used to create an animation. They are: Key frame, Tween 

frame, frames, and Blank Key frames. 

 ² Key Frame: A key frame is the main, specialised static frame in a series of 
frames to be used with the creation of an animation.  The user decides on the 
key frame for the creation. In a complete motion, there can be many key frames 
in important positions.  
E.g. - The frames used at the beginning and at the end of motion are Key Frames.

 ² Tween Frames: Animation is created in the Tween Frame. The purpose of a 
tween frame is to create smooth motion between two frames. While the user 
creates the key frames, the software creates the tween frame.  It is possible to 
create smooth motion of 24 frames per second (fps). In a motion consisting of 
24 frames, the additional 22 frames are created as Tween frames.
E.g. - There are two key frames; one at the beginning and the other at the end. 
In a motion of 24 frames, the rest of the 22 frames are created by the computer 
programme. Eventually, The user creates an animation with a smooth motion 
with little effort. 

 ² Frames: When an adjoining frame is added to a frame with a content, the time 
period of the content in the animation can be increased.

 ² Blank Keyframe: In every instance when blank key frame is added, it provides 
a blank frame to include a content. However, when a creation is done in this, it 
is no longer a blank key frame.
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Animation

Vectorian Giatto

Vectorian Giatto is produced for animations. It is a free software and can be 
downloaded from the Internet. This software is easy to use and requires no coding 
unlike with some other software for animation.    

The main purpose of this software is to embed motion for created images, 
while there are nearly 50 flash animation tools.

The specialty with Vectorian Giatto is in its ability to remain free from 
complex scripts and enable creation of simple animation including music.  

Vectorian Giatto software can be downloaded and installed in your computer 
from: http://vectorian.com/giatto

The Graphical User Interface of Vectorian Giatto

1

7 8

63 52 4

     
1. Drawing Toolbar     
2. Build-in-player
3. Layers
4. Timeline

5. Work Stage
6. Geometrical Properties and Shapes
7. Colours 
8. Properties Window
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1. Drawing Toolbar: A basic need of animation is to create an object or a text on 
a work stage for motion or editing. The tools that can be used for this purpose. 
are as follows:

Line tool (N)

Can be used to draw lines on the work stage.
1. Click on the tool.
2. In the column for the Shape, select type of line and colour, 

using the pen. Include the number for density. 
3. By clicking the mouse, keep drawing on the work stage.

   Note: On completion of 
drawing lines, it is possible 
to change type, colour and 
density as required.

           

density

colour

type                                     

            

Insert bitmap 
(M)

This is used to add a picture to the work stage. Image file formats 
that can be added to work stage are; 
Bitmap (bmp), JPEG (jpg),  TIFF (tif), PNG (png),  GIF (gif)
and ICO (ico).
1. Click on tool.
2. Select and open the image from 'Open' dialogue box.

T
Text tool

(T)

This is used to add text to the work stage.
1. Click on the tool.
2. From the Properties window which is opened at the same 

time, select font type, size and alignment.
      Select colours from 'Brush'
      Click mouse on work stage and type.     

Note; If ‘Properties’ window does not appear, 
Click 'Window → Object properties'
Changes can be done after the completion of typing.
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Oval tool
(O)

This is used to draw oval shapes on the work stage:
1. Select tool. 
2. Select border type, colour and density from 'shape' bar.
      and select colour using ‘Brush’.
3. While clicking mouse, continue drawing on work stage.

Single colour
colour 

combination
Image

In the colouring process:
 ² One colour
 ² Combination of colours or a picture can be used.

Rectangle tool 
(R) 

 ² This helps draw rectangular shapes on work stage. Follow 
steps used to draw oval shapes discussed earlier.

Pencil tool (P) 

 ² This can an be used on the work stage to draw free lines.
1. Select tool.
2. Follow steps that were used in drawing lines earlier.

Brush tool (B) 

This can be used to draw wider shapes on the work stage. 
1.   Select tool.
    Follow the steps described for drawing lines, using the pencil.
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Selection tool (V)

Selection tool is used to select or move around shapes, 
texts and pictures. 

1. Select tool.
2. Place the arrow head on the 

object and click.
3. If the object gets covered in 

small white dots, the picture 
or object is selected.

Sub selection tool (A)

This is used to change the appearance on the created 
shape.
1. Select tool.
2. Click on the shape to be 

changed.                
3. Click on the marks around 

it, drag in or out to do the 
change.

Lasso tool (L)

This helps to cut and remove shapes or pictures on work 
stage.
1. Select tool.
2. Click on the image and get the selection.

Free transform tool 
(Q)

This is used to change dimension, rotate or change the 
shape of the object.
1. Select tool.                      
2. Click on object.
3. Click on tools around the object 

and do the changes.

Ink bottle tool (S)

This is used to change the border around shapes drawn 
on the work stage.           
1. Select tool.
2. Use 'Shape → Pen' to select area, colour and type.
3. Click on 'Object'. 
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Paint Bucket tool (K)

This is used to change colour on shapes drawn.
1. Select tool.
2. Use 'Shape' → 'Brush' to select a colour or a 

combination of colours

Eyedropper tool (I)

This is used to select a colour combination on one object, 
to be used on another object elsewhere.
1. Select tool.
2. Click on object with a necessary colour.
3. Click on the object where there are no colours. 

Eraser tool (E)

This is used to erase only a section of a creation. 
However, this does not remove the entire shape. 

2. Built-in-player - Built-in-player is used to play, stop, rewind or move to end 
with an animation created. 

Stop

Start

Rewind
End frame

3. Layers - Layers are important in 
the creation of simple and complex 
animation. The use of different 
layers helps with the organization 
of different objects in animation.  
Layers are similar to a collection of 
transparent papers. Getting one object 
on to another can obstruct the lower 
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layer. Usually, when Giotto is opened, the first layer can be seen. It is named 
Layer 1. Right click on the layer frame can bring up another layer, remove one, 
make the layer visible or not, lock/unlock the layer and place it in the correct 
position.  

4. Timeline - Timeline is an important feature in animation. Timeline sets time 
period for animation.  

5. Work stage - Animations are created on the work stage. 

6. Geometrical Properties and Shapes - The geometric 
properties and shapes window is used in colouring the 
shapes. This window is also helpful with the selection 
of border type and adding border colour, combination of 
colours, drawing designs and inserting images.

7. Colours - Basic colours for the tools (Pencil, brush, ink, 
bucket, letters) are selected from this window. Colour for 
the border is from 'Pen' and fill colour from 'Brush' can be 
obtained.

8. Properties Window - In the selection of text tool, the properties window that 
changes accordingly can be used to select font size, font type, alignment etc.
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Basics of animation

Open a new window 
to create an animation File → New Movie

 ² Click 'File → Save' 
 ² Type a name in 'Save Image' dialogue 

box
 ² Select a location to save from 'Places' 
 ² Click 'save'

Saving an animation

A file created by Giotto software is saved in the .vgd file format. The file can be 
saved to be used in web designing as well. This is called 'Export Flash Movie' and 
saved in .swf file format.  

To save as .swf file formats; Select 'File' 
→ 'Export Flash Movie'.
 ² Select the location for saving, give file 

a name and click 'Save'.
 ² Thereafter the 'Export Settings' 

dialogue box opens.  Select 'Compress 
movie' and click 'OK'.

Export saved 
animation files to 
other file formats

Open a saved
 animation                                         

 ² Click 'File' → 'Open' and open it from 
the saved location.

To open the file as an animation,
 ² Open the saved location.
 ² Right click on the file.
 ² Select the web browser you use.
 ² It can be seen that the animation plays 

in the browser
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Creating a simple animation using Vectorian Giatto 

Step 1 -  Open Giotto software. 

Step 2 -  On top of the work stage, draw  
  two shapes - a square and an  
  oval, as shown in the illustration.

Step 3 -  Using the tools to select these 
	 	 shapes,	 draw	 border	 and	 fill 
  colours using the Pen and Brush.

Step 4 -		 Observe	 that	 this	activity	 is	 shown	 in	 the	first	 frame	 in	Timeline.		
	 	 This	is	the	first	basic		key	frame.

 

Step 5 -		 Right	click	on	frame	24	in	Timeline	and	select	 'Insert	Key	frame'.		
	 	 Frames	1	to	24	can	be	seen	as	follows;	 

Using Selection tool, drag the square the 
oval	drawings	to	the	bottom	created	on	the	work	
stage.  

Step 6 - 	 Right	 click	 on	 any	 frame	 in	 
	 	 Timeline,	1	–	24.	From	the	menu 
	 	 that comes	 up,	 select	 'Create	 
	 	 Motion	 Tween'.	 The	 Timeline	 is 
  seen as follows.
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Step 7 -  Use Built-in Player to play the animation.

If it is necessary to increase or decrease the speed in an animation or to 
change the background colour or dimensions.
Click 'Modify' → 'Document'. From the dialogue box that opens, select 
'Document properties' to do necessary changes. Click 'OK'.  

To change 
background  

colour
Increase/

decrease rate 
of frames 
per second 

and increase/
decrease speed

volume

Creating animation with captions

Step 1 -  Open Giatto software. 
  
Step 2 -  Draw a rectangle on work stage  
  as shown.

Step 3 -   Select 'Brush' → 'Linear' to 
  arrange colours and fill colour  
  using 'Colour basket'.

Step 4 -  Double click on Layer I. Label 
  it as ‘Background’. 

Step 5 -  Right click on layer and select '+ 
  Layer' 

Step 6 -  Label this layer as ‘Text’ 

Step 7 -  Select 'Text' layer.  
  Using text tool, type ‘Beautiful  
  Sri Lanka’ on work stage. 
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Step 8 -  Select text and using Properties 
  window, edit caption. 
  (Font type – Curlz MT, font size – 
  35)   
  Centre the text as shown.

Step 9 -  Right click on the text and select. 
  'Effect' → 'Add'.

Step 10 -  'Effect' window shows many effects  
  that can be added to the text 

  Select 'Falling Leaf'. Click 'OK'.
  

Observe the changes in the 'Text' frame 
accordingly.

 

Effects have brought about changes to the Text frame. The background time 
frame too has to be edited accordingly.

Step 11 -  Select 'Background time frame'. Right click on 83 frame (The end of 
  the text frame) and select 'Insert' key frame.

Step 12 - Save the animations, export and open.

 Activity

Create an animation by adding a motion text using an image you have 
created.

4.3  Audio Content 
In the last lesson, we learnt about creating still graphics and animations for 

effective communication. To make such creations more meaningful and attractive, 
voice or sound can be added. Files that are created using recorded sounds or voices 
are known as audio content. These files can be edited as necessary using computer 
software. Some such software are as follows:
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 ² Audacity 
 ² Power Sound Editor 
 ² Mp3DirectCut 
 ² Music Editor Free 
 ² Wavosaur 
 ² Ardour 
 ² WavePad Sound Editor 
 ² Sound Engine

Audio editing 

Audacity

Audacity is a free software that can be installed in Windows, Mac and  Linux 
operating systems.  Audacity can be used for both editing and recording purposes. It 
consists of multi layers. In installing the software, the user can select the language 
in the interface to suit user's choice.  

Audacity has functions for;

 ² Recording live audio proceedings
 ² Recording music being played in the computer
 ² Inserting sound effects on recorded digital graphics write on CDs/DVDs content. 
 ² Editing file formats such as WAV, AIFF, FLAC, MP2, MP3 or Ogg Vorbis
 ² Copying sound, trimming, mixing, or joining together for editing purposes
 ² Changing speed and pitch in recordings

Audacity can be downloaded from the following URL;

http($$audacity.sourceforge'net$
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Audacity Interface

1 2 3 4 7 5 8

6

10

11

12

13

14

9

1. Menu Bar
2. Transport Toolbar
3. Tools Toolbar
4. Recording Meter Toolbar
5. Playback Meter Toolbar
6. Mixer Toolbar 
7. Edit Toolbar
8. Transcription Toolbar
9. Device Toolbar
10. Timeline 
11. Track Control Panel 
12. Audio Track
13. Selection Toolbar 
14. Status Bar
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Basics of using software for sound effects

Open a new window 
for creating audio 

content.

File → New

Saving a created 
audio content.

 ² File → Save
 ² Select location for saving, type a file 

name and click 'Save'.

The file format used to save Audacity file is .aup. File saved in this format can be 
edited. 
It is also possible to save such a file so as to use in web designing. This is known 
as audio exporting. There are several file formats where the animation can be 
saved. Some of them are: WAV, AIFF, FLAC, MP2, MP3.

Export Audio

 ² Select 'File' → 'Export Audio'.
 ² Select the location for saving. Give it 

a suitable name.
 ² Select required file format from of 

'Save as type'. Click Save. (Audio 
content compresses at this stage) 

 ² Dialogue box 'Edit Metadata' opens.   
Using it, provide details such as 
audio mixing (name, year, title etc) 
and click Ok.

Audio Recording with Audacity

Step 1 - Click  'File' → 'New'.

Step 2 - Click 'Record' on Transport Toolbar.

Step 3 -  Using the microphone built into the computer, record the required 
  audio content.

Step 4 -  Click 'Stop' on Transport Toolbar to end recording.

Step 5 - Click Play and listen to the recording done.
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Play

Stop

Record

Editing recorded sound track to remove unnecessary sections

Step 1 - Open created file saved using -.aup (Audacity Project) file format. 

Step 2 -  Using Selection tool on Transport Toolbar select the necessary
  sections in the audio content. 

 Selection 
Tool

Step 3 -  Click 'Trim Audio' on Edit Toolbar. This helps remove unnecessary 
  sections.

 

Trim Audio

Step 4 -  On completion of editing, Save edited file.

4.4   Creating a video clip

A video created using a series of visuals is called a video clip. For this, a 
recorded video, or still pictures and audio content can be used. Software can be 
used to create and edit video content.  
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Some software that are used to create video clips and edit as follows;
 ² Photo Bucket
 ² YouTube Remixer
 ² Movie Masher
 ² One True Media
 ² Motion Box
 ² Stash Space
 ² Windows Movie Maker
 ² AVI Edit
 ² Super DVD Video Editor

Use of video editing software to create video clip

Windows Movie Maker
Windows Movie Maker is a free software provided by the Microsoft             

co-operation. This software can be used to create and edit video clips.
Download and install Windows Movie Maker software from the URL given below.

http://www.windows-movie-maker.org/

Windows Movie Maker – Interface

1 2 3

1. Preview/Player pane
2. Timeline stage
3. Editing function panel
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1. Preview/Player pane
This is used to view a video and image frames expected to be used in a 

video clip and to watch a created video clip before saving it. 

2. Timeline stage
The video clips to be created, the image frames and the audio clips are 

arranged on Timeline stage. Unlike on a time frame, the images and image frames 
are displayed very clearly.

3. Editing function panel
The tools in the editing function panel are important for editing video clips 

that are created. These tools can be used to edit video content, add visual effects and 
edit audio content. 

Making a video clip with Windows Movie Maker

Step 1 -  Open Windows Movie Maker software.

Step 2 - Using 'Home' → 'Add Videos' & Photos' open video clips for the
  creation.
  The screen to appear will look like as follows:
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Apply Transition

Transition is used to show the relationship between two image frames and 
the manner in which the frames appear.  

Step 1 -  Open menu ‘Animations’.

Step 2 -  Click on first frame.

Step 3 -  Take the mouse along each transition. The selected image is
  displayed in various forms. Then, click on the suitable transition.

4. Apply suitable transitions to other images on the Timeline stage. After applying 
transitions, Timeline stage is shown as follows.

5. Using the Preview/Player pane, play the creation. Edit as necessary.

6. To arrange the time period to display an image 
frame, use 'Animations' → 'Duration'. Select 
'Apply to all' to enable use of same effects for all 
image frames.   

7. To move image frames:
  i)   Select the image frame.
  ii) Use Mouse over each movement shown in 'Pan and Zoom'. Click on

     suitable motion.

8. To add a topic to the creation:
i)   Select first frame.
ii)  Select 'Home' → 'Title'.
iii) Type a suitable topic.
iv) Open Format menu.  Add Effects to suit topic.
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9. Captions can be added to each image frame.  For this purpose:
i)   Select image frame.
ii)  Select 'Home → Caption' and type a suitable caption 
iii) Format as shown earlier.

10. At the beginning or at the end of the video content, the direction, artists, music, 
venue etc. can be introduced. Separate frames can be added for this.

i)  Select the necessary introduction from 'Home → Credits'.
ii) Type in necessary information.

Thanks

Direction

Contributing artistes

Locations used

Music

11. The video content can be more effective by adding an audio content.
i)  Select first frame
ii) Select 'Home → Add music'

12. Select and open an audio file prepared beforehand. At the end, the timeline 
stage is shown as follows:

13. Play the video content. Edit as necessary.
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Saving an animation

'File' → 'Save Project'

Select a location for saving. Give file a suitable name. Click 'Save' to save 
the file.

A video clip that is created using Windows Movie Maker is saved .Wlmp (Movie 
Maker Projects) format. Files saved in this format can be edited. 
Video clip can be saved so that it can be viewed through web browser and social 
media (Facebook, You Tube, Flicker)

Saving and distribution of video content as a video clip

Method of saving a video content as a video clip to be watched on a 
computer, television, mobile phone or to open in social medias as follows;

Step 1 -  Select the medium to save by  'File' → 'Save Movie'

Step 2 - Select location to save, give the file a name and click 'Save'.

For a e-mail

For computers

For high - 
definition 
display

For mobile 
phones

 

For social media

as an audio content

Various media of file saving
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Activity

1. Create a few still graphics using photographs of special places of 
Internet in Sri Lanka using the lesson learnt in this chapter.

2. Create a few two dimensional animations by using the still graphic 
in the background.

3. Include an audio content to suit the created graphics and animation.
4. Using the creations above, prepare a video clip about the places in 

Sri Lanka.  
5. Compare and contrast lossy and lossyless graphic compression.
6. Compare and contrast raster graphic and vector graphics.

 ² Images or graphics created using graphic software are known as digital 
graphics.

 ² Basic elements of a digital graphic are pixel, resolution, size and colour.
 ² Pixel is the basic element of a digital graphic. Digital graphics are made up 

of thousands of pixels.
 ² Pixel is composed of bits. Single colour pixel is made up of 8 bits while a 

colour pixel is made up of 24 (8×3) bits.
 ² The unit to measure the physical dimension of a digital graphic is pixel and 

physical dimension is known as image resolution.
 ² A high resolution digital graphic has higher quality.
 ² There are two types of colour models;

 ¾ RGB model (Red, Green and Blue)
 ¾ CMYK Model (Cyan, Magenta, Yellow and Black)

 ² Single colour- Primary colours
 ² Two colours - Secondary colours
 ² Three colours - Triplet colours
 ² There are 256 (1 - 256) colours 
 ² RGB Triplet is formed from 000,000,000 to 255, 255, 255
 ² For example ‘RGB Triplet’ = RGB (245, 102, 36) = RGB (F5, 66, 24) 

Summary
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 ²  There are two forms for graphic compression;
 ¾ Lossy
 ¾ Lossless

 ² There are two types of graphics:
 ¾ Raster Graphic
 ¾ Vector Graphic.
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   After studying this chapter, you will understand the following:

 ² Content of a website
 ² Fundementals of Web designing
 ² Publishing a website
 ² Maintaining a website

5.1 Structuring information for web designing
 
 There are several aspects that attention should be paid when designing a 
web site. Imagine you are member of a group of students assigned to design a 
website. You should consider factors such as the purpose, the user, and how to 
maintain the website etc.

5.1.1 Web applications

There are several web applications. Examples are as follows. 

i)    Information Communication
 There are websites designed to communicate various information such as 
educational and health for the users. 
Example - www.nie.lk, www.surgery.lk, www.webopedia.org

ii)   e Commerce
 This includes websites which sell goods and services through the Internet.
Example - www.farlin.lk, www.lego.lk, www.amazon.com

iii)  Entertainment
 There are websites for entertainment which provides download materials 
such as songs, films and teledramas, games, broadcasts and telecasts
Example - www.islandcricket.lk, www.netflix.com, www.youtube.com

5 Web Designing Using Multimedia
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iv)   Advertising
These websites provides information on goods and services provided by 

various organizations. 
Example - www.onclickads.net, www.adcash.com, www.myadvertisingpays.com

v)    News
These websites publish news using multimedia.

Example - www.itnnews.lk, www.rupavahini.lk, www.bbc.co.uk

vi)   Social Media
These websites provide facilities to develop social networking among 

various groups depending on their educational background, occupation, tastes or 
other factors.
Example - www.facebook.com, www.linkedin.com, www.twitter.com

vii)  Search engine
These websites provide facilities to find information from the World Wide 

Web using a word or a phrase as the key.
Example - www.google.com, www.msn.com, www.bing.com

viii) Personal
These are often used by popular persons such as writers and politicians to 

disseminate their information.
Example - www.president.gov.lk, www.arthurcclarke.net, www.nelsonmandela.org

5.1.2 Web user groups

Those who access a website and use are known as the users of the website. 
For instance, www.google.com is used by many people around the world and they 
are the users of the Google website.

In designing a website, it is understood that the user is important. The 
following are useful in understanding them:

1. Language and culture
2. Age
3. Educational level
4. Gender
5. Preferences
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When designing a new website, various methods can be used to understand 
the target user group.
For instance,

1. conducting a study on target users.
2. Analyzing similar websites.

For example, let us consider, the home page of the official Website of Sri 
Lanka (Figure 5.1) and website of Telecommunications Regulatory Commission of 
Sri Lanka. (Figure 5.2). You can observe that there are facilities to access them in 
all the three languages.

The website in Figure 5.2 provides the facilities to change the font size 
according to the user preference and to access social networks. 

To access Sinhala 
medium

To access English 
medium

To access Tamil 
medium

Figure 5.1 - Home Page of www.srilanka.lk 
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Change font 
size

Search

Videos
Images

Texts

Copyright and the 
last updated year Navigation between 

web page

Change the 
language

Hyperlinks for 
popular social 

networks

Figure 5.2 - Home page of www.trc.gov.lk 

5.1.3 Web content

All the audio-visual information and services a user comes across in a 
website are called its web content. The web content of the new website should be 
selected considering the need/s of the user identified in the user group analysis. 
Web content should include the information to be communicated to the user as well 
as all the services to be provided to the user.

Various types of information and services can be found in the web content 
of websites. Following are some of them:

 ² Texts : information given in short 
 ² Images : photos taken from a camera, clip arts, drawings, scanned
 ² Sound : songs, voice clips  
 ² Video : video clips 
 ²  Animations 
 ² Copyrights and information about updates
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 ² Hyperlinks to other documents, pictures, audio-visual files, and social 
networks  

 ² Advertisements
 ² Search facilities
 ² Facilities to download certain software required to use the website. 

As an example of identifying web content, examine the website of 
Telecommunications Regulatory Commission (www.trc.gov.lk) given in Figure 5.2.  

5.1.4 Content Management

Systematic organization of the selected content of a website is known 
as content management. The main objective of this is to provide facilities to the 
users to use the website more effectively. Given below are some features of a well 
organized website.

 ² Easy to use 
 ² Can find the information user needs fast
 ² Attracts users
 ² Easy to update
 ² Has room to add new features later

If the amount of information selected for the web content of the website is 
small, organizing web content is easy. However, if it contains a large amount of 
various types of audio-visual information, various methods are used organizing 
web content of such websites. Following are some examples;

1. Classification based on site map

By developing a site map to classify the web content, one can get a clear 
picture about the web pages need to be created in the website and the hyperlinks 
(link among pages) need to be created among these. For instance, in the site map 
shown in Figure 5.3 - website of a school, the  number of web pages need to be 
created is indicated in square structures and the hyperlinks need to be created for 
interlinks among those pages are indicated in lines.
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Home Page 

Current 
Information 

History Sports Old 
Pupils

School 
Development 
Committee 

Contact 

Elle
Literature Buddhist English 

Cricket Volley ball

societiesManagement 

Structure 

Figure 5.3 - Site map of website of a school

2.  Display a summary of the entire content of the website in the home page
To manage the space in the home page;

 ² Use of main menu and sub menu (Figure 5.4)
 ² Use of hyperlink (Figure 5.5) ²

Sub Menu 

Main Menu 

Figure 5.4 - Main menu and Sub Menu 

3.  Present information in brief
The attention of the user may not be drawn to some information, when 

a large amount of information is included in a single web page. Therefore, the 
content of a single web page should be limited.

4.  Use of numbered lists, bulleted lists and indentation
This prevents the user getting exhausted by reading long text paragraphs. 

5. Providing the facility for the user to navigate the website easily 
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6.  Updating
Web site should be easy to update by the person maintaining the site. The 

accuracy of information is assured when the copyrights and the updated time 
periods are included clearly in each page.

5.1.5 Structure and layout

Structure and layout are the features such as backgrounds, tables, frames, 
font types, font sizes, font shapes. Some of them are as follows;

1. Maintaining the identity of the website in each page 
This means preserving the identity of the web pages of a single website by 

keeping uniformity between backgrounds, font types, font sizes, font shapes etc.  

2. Highlighting important information 
For this, methods such as changing the font types and font sizes or different 

colours in the related information can be adopted.

3. Ability to access the website from any computer

Figure 5.6 - Various sizes of screens

Various users use different 
types of personal computers, various 
devices such as mobile phones to 
browse websites. Different sizes of 
screens are used as shown in Figure 
5.6. Since the screen resolutions 
of these devices are different, 
some web pages are displayed in 
different ways on different screens. 
The website should be constructed 
in order to adjust the size of the webpage to that of the screen automatically. 

Activity

Examine the websites given below with your teacher and discuss the 
strengths and weaknesses in their design.

 www.srilanka.lk  www.schoolnet.lk
 www.doenets.lk  www.bbc.co.uk/education
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5.1.6  Selecting media resources

When selecting any type of media resource for a website such as various 
texts, pictures, sounds, videos and animations, several factors should be considered. 
The following are some such things to be considered;

1.  Size
There is a very close connection between the size of media resources 

accommodated to a certain web page and the time taken to download that web 
page. If the size of these is high, more time is spent to opening that web page as 
more data should be downloaded from the web server to the users' computer (client 
computer). Since the users have to stay for a long time to use the web page, there 
may be a possibility for them to leave the site. Therefore, various methods are 
followed depending on to the media type. Following are some examples;
 ² Graphics

 ◦ Reducing the amount of pixels by removing unnecessary sections using 
Crop/Trim in graphics software

 ◦ graphic compression
 ² Video files

 ◦ Reducing frame size
 ◦ Reducing resolution
 ◦ Adjusting frame rate
 ◦ Removing unnecessary frames and sound

 ² Audio files 
 ◦ Reducing the bit rate
 ◦ reducing the sample rate
 ◦ reducing number of channels
 ◦ removing or reducing unnecessary sound

2.  Use of media resources adhering copyrights
If you use media resources created by another person in your website, it 

is your responsibility to obtain necessary permission from the owner. If not, it is 
unethical and may lead to legal issues as well. 

However, as per the fair use of principles, it is possible to use media resources 
without permission for activities such as news reporting, academic purposes and 
critic.   
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Activity

Develop a plan to school website related to sub topics 5.1.1 to 5.1.6 
mentioned above.

5.1.7  Use of Basic HTML   

Hyper Text Markup Language, which is known as the acronym HTML, 
is the language used for documents in the World Wide Web. An HTML document 
which can be displayed through a web browser is called a web page. Unlike the 
computer programming languages you learnt earlier such as Pascal, the codes of 
HTML language shows the web browser how the web page content should be 
displayed on the computer screen. Hence, HTML is not a computer language but a 
Markup Language.   

Now let us design some simple web pages using HTML.

Figure 5.7 - Open Notepad

Activity No 01

Step 1 -     As shown in Figure 5.7 
  Start → All Programs →  
  Accessories → Notepad
  Notepad is a simple software  
  used in the Windows operating  
  system. 

Step 2 -    Write statements on the Notepad  
   as shown in Figure 5.8. 
                 

                     

Figure 5.8 - HTML statements written in Notepad 
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Step 3 - As shown in Figure 5.9, type the file name of that notepad page as 
  myfirst.html and select the file type as All Files. Then save it in a
  suitable folder.

Figure 5.9 -The dialogue box appear in saving the Notepad page 

Step 4 - Open the file myfirst.html. Your first web page will be displayed as 
  shown in Figure 5.10.

Figure 5.10 - An HTML file which is open

Step 5 - Instead of the phrases written on the notepad page in the second 
  step above “This is the title” and “My first web page”, write 
  different phrases and create more web pages.

Step 6 - Instead of using a word processing software like notepad, software
  which are called HTML editors can be used to write HTML code.
  Following are some software with the web addresses to download.

  1. CoffeeCup (www.coffeecup.com/html-editor)
  2. Seamonkey Composer (www.seamonkey-project.org)
  3. Eclipse (https://marketplace.eclipse.org/content/html-editor- 
      wtp)

  Install any one of the above software in your computer.

Step 7 - Open the web designing tool in your computer. Given in Figure 
  5.11 is how the HTML editor named CoffeeCup is opened after 
  giving the command File → New HTML document. 
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Figure 5.11 - Display of HTML editor in Coffeecup

You can see that a substantial number of phrases you wrote in step 02 on 
notepad page are automatically written here. It makes your task easier.

Now you can insert the items in the proper places in your web page. Figure 
5.12 shows how the phrases “This is the title” and “My first web page” you inserted 
in the first web page.

Save this in your folder as coffeecup.html using the command File → Save 
As.

Preview tool

“This is the Title”

“My first web page”

Figure 5.12 - Insert elements in CoffeeCupHTML editor 
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Step 8 - Now check the web page using preview tool. Design more web
  pages by inserting more new phrases.

Observation

So far you have written HTML documents which include phrases 
of HTML language or HTML codes using notepad and other 
tools.

What you use in angular brackets like <html>, <head>, <title> are types of 
HTML tags, which is a main feature of HTML. These tags indicate to the web 
browser how the web page content should be displayed to the user. This means 
the structure and layout you have selected are entered in the web page using 
HTML tags. 

5.1.8 The Basic Structure of an HTML Document

Figure 5.13 given shows some essential tags in the basic structure of an 
HTML document. Mostly, a tag consists of an opening tag and a closing tag. 
However, you will later come across some tags later which consist of an opening 
tag only. 

<html>
 <head>

 </head>

 <body>

 </body>

</html>

Starting html tag  

Starting head tag  

Closing head tag 

Starting body tag    

Closing body tag   

Closing html tag   

}
}

head

body

Figure 5.13 - Basic structure of a HTML document

An HTML document consists of two main parts; head and body. The figure 
5.13 shows clearly that the opening <html> tag shows the opening of the document 
and the closing </html> tag shows the ending of the document. 
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Web page content should be included in the body part. Consider how you 
indicated  “My first web page” in your first web page. 

There are special occasions where you make notes in the Head part. For 
instance, consider again how you mentioned “This is the title” in <title> tag in your 
first web page. This is displayed on Title Pane which is at the top most of your web 
page.

5.1.9 Features of HTML

i) HTML tags show the web browser how the web page should be displayed. Such 
commands in an HTML document are called HTML codes.

ii) There should be a pair of angular brackets (< >) at the beginning and end of an 
HTML tag.

  E.g. -  <p> to mark the beginning of a paragraph

iii) Generally, HTML closing tags are given in pairs. “/” (back slash) with the name 
of the tag should be indicated in the ending tag. 

E.g. -   <p> to mark the beginning of a paragraph and </p> to mark the end of          
           it 

iv) Generally HTML tags are not case sensitive. That means, the use of capital or 
simple letters of the English language does not affect the meaning.

E.g. -  <TITLE>, <Title> or <title> does not make any difference.

v) There will be no error messages if the tag is indicated incorrectly, however, the 
web browser will ignore that particular.

vi) There are three parts of an HTML tag – element, attribute and value.
E.g. -     Following is the HTML code to display the plain text “I am a student”  
           in Times New Roman font type in blue colour. 

<font face=“iskoolaPota”  color = “blue”> I am a student </font>

Attributes

values

Element
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The features related to a certain HTML are indicated in the opening tag only 
and the values related to it are always indicated within inverted commas. 

5.1.10 Designing a web page

Let us design a web page which gives a short introduction about “Sri Lanka” 
as given in Figure 5.14.

Title text

Picture

A paragraph

A hyperlink

A table

 Bullet rows    Bullet rows   

Figure 5.14 - A web page on a short introduction about Sri Lanka 

 Preparing the Title Text

Open a new web page using HTML editor. Then enter the HTML code 
as shown in the Figure 5.15. Save that web page in a folder in your computer 
and provide a suitable file name. Display the web page using a web browser and 
compare it with the output given in Figure 5.15 as well as the title text given in 
Figure 5.14.
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<html>
     <head>
    <title> Sri Lanka </title>
     </head>
     <body>
           <h2><center><font face="Arial" color="blue"> 
    SRI LANKA        
    </font></center></h2>
                </body>
</html>

O
u
t
p
u
t

SRI LANKA

Header tag Center tag Font tag

Figure 5.15 - HTML code to prepare the title text and its output

Let us consider the HTML tags further. 

Header tag

Methods such as increasing the font size, making the letters bold etc are 
used to highlight elements such as headings, sub-headings and other texts from the 
rest of the document. For a web page, this is carried out using the tag called header. 
There are header tags from <h1> to <h6> in the order. Out of these, <h1> makes 
the letters the biggest and the bold. The size and the thickness of the letters are 
decreased gradually from <h1> to <h6>.

Instead of <h2> tag of your web page, use other header tags and adjust the 
title to a proper size, after checking how it is displayed on the web page.   

Font tag

As you have learnt already, an HTML tag consists of three main components 
– element, attribute and value. There are three main attributes in the Font tag (ie.
size, face and color). The font size attribute shows the size of the letters. For this, 
you can assign the values in the range from 1 to 7. Default is size 3. That is the size 
displayed automatically by the web browser when you do not assign a value to the 
Font size. 

Font face attribute shows the type of letters. You can assign any type of 
letters available in your computer as its value. E.g. - “Ariel”, “Verdana”

Font color attribute shows the colour of the letters. There are two ways to 
assign values for this.
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i)   Providing the names of the sixteen standard colours as they are, in Figure 5.16 

Figure 5.16 - Standard Sixteen Colours

Example: <font   size =zz5" face =zzverdana"   color = zzfuchsia" >SRI  LANKA</font>

  
Output SRI LANKA

ii) Using RGB hexadecimal codes based on the basic colours red, green and blue, 
as shown in Figure 5.17. 

  The code is arranged here with six numbers from 0 to F preceding # sub 
feature. Here, the first two numbers represent the red, the next two numbers 
represent the green, and the last two numbers represent the blue. 

Figure 5.17 - Some RGB colour combinations

Example: <font size = zz5''  face = zzverdana" color = ''#0000FF'' >SRI  LANKA</
      font>

Output SRI LANKA
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Center tag

This is a tag used to align the title of your web page to the centre along the 
horizontal axis. This can be used not only for a text, but also for other elements such 
as a picture. 

There are several tags like the Center tag which can be used to design texts. 
Given below in Table 5.1 shows some of them.

Table 5.1 - Text Formatting Tags

HTML symbol How the letters are 
designed

Example

<b> Bold SRI LANKA 
<i> Italic SRI LANKA
<u> Underline SRI LANKA

<em> Emphasis SRI LANKA
<s> strike out SRI LANKA

<sup> Superscript SRI LANKA

<sub> subscript SRI LANKA
<marquee> horizontally moving text (Check this by applying to a 

web page) 

Example:  <b> SRI  LANKA </b>

Output SRI LANKA

Refer following sites and study further about HTML tags used to design texts in 
web sites.

Example:  http://www.w3schools.com/html
  http://www.tutorialspoint.com/html

Activity

Design a web page using the name of your school instead of the school 
name given in the Figure 5.18. Use different designs you wish to add 
using Sinhala unicode font (“iskoola pota”). Change 'Encoding' as 
unicode in 'Save As' dialog box when saving the document (Figure 
5.19). Compare your web page with the output shown in Figure 5.20.
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<html>
<head><title> Text Formatting </title></head>
<body>
        <font face = ''iskoola pota'' color = ''Green'' ><h1> 1' name of your school  </h1></font>
        <font face = ''iskoola pota'' color = ''lime'' ><h2> 2' name of your school </h2></font>
        <font face = ''iskoola pota'' color = ''olive'' ><h3> 3' name of your school </h3></font>
        <font face = ''iskoola pota'' color = ''Navy'' ><h4> 4' name of your school </h4></font>
        <font face = ''iskoola pota'' color = ''blue'' ><h5> 5' name of your school </h5></font>
        <font face = ''iskoola pota'' color = ''Aqua'' ><h6> 6' name of your school </h6></font>
        <font face = ''iskoola pota'' color = ''Teal'' ><h6> 7' name of your school </h6></font>
</body>
</html>

Figure 5.18 - HTML document

Figure 5.19 - Save as dialog box related to activity above

Figure 5.20 - Output 
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Activity

1. Find out other text formatting tags by referring to websites and 
books related to HTML codes and prepare a table similar to the 
Table No 5.1.

2. Design a web page using other text formatting tags instead of header 
tags given in Figure 5.18. 

3. Study <marquee> tag further and design a suitable web page.  

Inserting and formatting an image

Select a picture suitable to insert to your web page. When inserting images 
to a web page, it should be relatively low size file type such as .png , .gif or .jpeg. 
The images to be used in the HTML document can be saved in a separate folder. 

Image tag

<img> tag, which is called the image tag, is used to link an image to a web 
page. This tag does not have two opening and ending tags. You will come across 
several such tags later which are called blank tags or empty tags. Though there are 
about 12 attributes related to the <img> element, only some important ones are 
explained in Table No 5.2.

 Table No 5.2 - Some attributes related to <img> element

Attribute Explanation about the value Example
source or 
src

The image file name should contain the file 
extension also. If the image is in another folder, 
the relevant path should be given. 

src=“C:\Users\
Pictures\pet.png”

alternative 
or alt

If the image given by the src attribute is not 
available in the text, that should be displayed 
image position indicated here.

alt = “map”

width The width of the image to be displayed is indicated 
as the number of pixels or as a percentage of the 
size of the page.

width = “100” or 
width = “50%”

height The height of the image is indicated as the 
number of pixels or as a percentage of the size 
of the page. 

height = “100” or 
height = “50%”
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border If a border is needed around the picture, its 
thickness should be indicated as the number of 
pixels. Or else, indicate its vaule as “0”.

border = “3”    

align A suitable alignment value can be used among 
left, right, top, bottom, and middle.

align = “middle”  

Output

Example - 
< img   src = ''C:\Users\Pictures\srilanka.jpg'' 
alt = ''Map'' width = ''100''  height = ''200''  
border = ''3''  align = ''middle'' > 

Enter the code as in Figure 5.21 in order to insert the image to web page on 
Sri Lanka in section 5.10. Open the web page on web browser and compare it with 
the output in Figure 5.14.

<html>

<head><title> Sri Lanka </title></head>

<body><h2><center><font face="arial" color ="blue"> SRI LANKA 
  </font></center></h2>
  <center><img src=" C:\Users\Pictures\srilanka.jpg"
  ></center><center><font face="arial" size="2">
   A map of Sri lanka  </font></center>
</body>
</html>

O
u
t
p
u
t

Figure 5.21 - Code to enter the image and the output 

Inserting and formatting a paragraph

To insert a paragraph below the image, insert the code given below in Figure 
5.22 to the web page. Open the web page and compare with the output in Figure 
5.23 and Figure 5.14. 
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<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
 <center><font face="arial"  size="2"> A map of Sri lanka  </font></center>
<p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is  
 surrounded by the Indian Ocean. The geography of Sri Lanka includes 
 coastal plains in the north and hills and mountains in the interior. The 
 government system is a republic.  The chief of state and head of government  
 is the President. </p>
</body>
</html>

paragraph tag Paragraph

Figure 5.22 - Insert a paragraph 

Figure 5.23 - Output of code in Figure 5.24

Let us learn about the <p> tag further which is used as the paragraph tag.

Paragraph tag

The paragraph inserted using the <p> tag is left aligned by default. Four 
different types of alignments can be used on “left”, “right”, “center” and “justify” 
attribute in <p> tag. 
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Table 5.3 - Paragraph alignment

Example Tag Alignment
< p align = ''left'' > Left

< p align = ''center'' > Center

< p align = ''right'' > Right

< p align = ''justify'' > Justify

How to keep a gap between words  
 

This is provided by using &nbsp: tag which belongs to the the type of 
character entity tags. 

<p> The government system is &nbsp;  a republic. The chief of state and head 
of government is &nbsp; &nbsp&nbspthe President. </p>

Output

The government system is    a republic. The chief of state and head of 
government is          the President. 

Activity

Identity some more tags which belong to the character entity type by 
referring to various websites or books related to HTML codes.

Inserting some rows

 Enter the code given below in Figure 5.24 to your web page to insert some 
rows below the paragraph you entered in the third step. 
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Line break tags

Figure 5.24 - Code to insert a few rows    

Figure 5.25 - A part of the output related to the code given in Figure  5.24    

The <br/>  tag, which is called the line break to break lines, belongs to 
the type of blank tags/empty tags similar to the <img> tag you have used earlier. 
Identify that only <br/>  tag is used exactly in the position where you need to break 
the line, without using two opening/ending tags.

Inserting Lists   

When a number of related items are indicated in an order, it is called a list. 
Mostly, these items are indicated one below the other. There are three types of main 
lists in web page designing in the HTML language. 

i)  Unordered lists
<ul> symbol is used to mark the beginning of an unordered list and the type 

attribute is used to show the shape of the special symbol with its element. Here are 
the three values which can be assigned to it.
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1. Disc
2. Square
3. Circle 

<li> tag is used to separate each item in the list.

 ² Sinhala
 ² Tamil 
 ² Muslim 

 ² Burgher
Output

<ul type = ''disc''        <li> Sinhala</li>        <li> Tamil</li>        <li> Muslim</li>
       <li> Burgher</li>
</ul>

   Figure 5.26 - <li> tag and its output

ii)  Ordered list
A number of items arranged in order using numbers or letters are called an 

ordered list (Figure 5.27). Two tags - <ol> and <li>, are used together to indicate 
these in web pages. 

Table No 5.4 - Values which can be assigned to <ol> type attribute and their meanings 

Value Meaning
1 Hindu Arabic numbers 
A English capital letters 
a English simple letters
i Roman numbers with English simple letters
I Roman numbers with English capital letters

Example - 

I. Sinhala
II. Tamil
III. Muslim 

IV. Burgher

Output

<ol type = ''I'' >
 
       <li>Sinhala</li>
 
       <li>Tamil</li>
 
       <li>Muslim</li>
       <li>Burgher</li>

</ol>

Figure 5.27 - Ordered Lists
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iii)  Description/definition list
Description lists are used to provide a description with the list (Figure 5.31) 

Table 5.5 - Description list

Tag Description
<dl> Beginning of a description list
<dt> Introduction of list
<dd> Description of the list

Example: Write the HTML code as given below to display a description list as
      shown in Figure 5.28 in a web page and check the output.

Output

<dl>
     <dt> Main subjects for the science stream </dt>
    <dd> Biology </dd>
    <dd> Physics</dd>
    <dd> Chemistry </dd>
    <dd> Combined Maths </dd>
     <dt> Main subjects for the commerce stream </dt>
    <dd> Economics </dd>
    <dd> Business Studies </dd>
    <dd> Accountancy </dd>
<dl>

       

Figure 5.28 - Description list

Activity

 Design web pages which contain lists as above using items you 
like.
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4. It is possible to design web pages in a way that one type of a list contains 
another type of list. Given below is such a code and its output which is 
displayed in Figure 5.29. Build various forms of similar lists.

Figure 5.29 - Coding of different lists and its output

<ul type = ''disc''>
    <li>Sinhala</li>
    <li>Tamil
 <ol type = ''1''>
 <li> Sri Lankan Tamil </li>
 <li> Indian Tamil </li>
 </ol> </li>
   <li> Muslim </li>
   <li> Burgher </li>
</ul>

O
u
t
p
u
t

Hyperlink 

Let us create a hyperlink for “President” as shown in Figure 5.14. Enter the 
code for it to your web page as given in Figure 5.30. 

<html>
<head><title> Sri Lanka </title></head>
<body><h2><center><font face="arial" color="blue"> SRI LANKA </font></center></h2>
 <center><img src=" C:\Users\Pictures\srilanka.jpg" ></center>
 <center><font face="arial" size="2"> A map of Sri lanka  </font></center>
 <p>  Sri Lanka is an island located off the southern coast of India. Sri Lanka is surrounded  
  by the Indian Ocean. The geography of Sri Lanka includes coastal plains in the 
  north and hills and mountains in the interior.The government system is a republic. 
  The chief of state and head of government is the 
  <a href=”http://www.president.gov.lk“ >President.</a></p>
  People in Sri Lanka have four main categories in ethnically. They are <br/>
       Sinhala <br/>Tamil <br/> Muslim <br/> Burghers <br/>
</body>
</html>

href attributeAnchor tag Attached file 

Figure 5.30 - Creating a hyperlink for a text 
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Figure 5.31 - Output of the code related to the hyperlink

While displaying the web page, more the Mouse to the text “President” 
which contains the hyperlink. 

The related file can be opened by double clicking on them or by giving the 
Open command after right clicking. 

Anchor tag

Hyperlinks can be created for a certain text or image by using <a> tag 
in HTML codes. There are some attributes related to this tag as well. The most 
important attribute which is href, shows the place which should create the link. If 
it is a file in the same folder which contains the web page, it is adequate to indicate 
the file name with the file extension. 

Example: <a href=“President.jpeg”>President </a>
  <a href=“President.html”>President </a>

However, if it should be connected to another web page, the relevant path 
should be indicated accurately. 

Example:  <a href=“http://www.president.gov.lk/president”>President </a>

Activity

1. Create a hyperlink to the picture of your web page with a suitable 
website in internet.

2. Prepare a list of attributes related to <a>  tag by referring to websites 
or books on HTML codes.
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Inserting a Table

Information such as various texts and pictures can be presented in a more 
organized way in rows and columns by including a table to a web page. 

After the HTML code written using the <br/>tag to include the four ethnic 
groups as Sinhala, Tamil, Muslim, Burgher in your web page, add the code as given 
in Figure 36 to include the table.

Table 
tag

Border attribute Tag for rows of the table    
Creating cells 
which include 

data

Figure 5.32 - Code to insert the table

Then display your web page and compare it with the output given in Figure 
5.33 which indicates the relevant section only, as well as with Figure 5.14

Figure 5.33 - Output related to the code of Figure 5.32 
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 Table Tag

 This tag marks the beginning of a table and the attributes to decorate the 
table are used with its element. Given below in Table No 5.6 are some of them.

Include these attributes to decorate your table.
Table 5.6 - Some attributes belong to  <table> tag

Attribute Explanation
align Shows how the table should be aligned with the other texts in the 

page. Left, center, right are used as values. 
width Shows the width of a table as the number of pixels or a percentage 

of the width of the web page.
height Shows the height of a table as the number of pixels or a percentage 

of the height of the web page.
bgcolor Shows the background colour of the table. Values can be assigned 

in the same way colours were assigned to the texts. 
border “1” is used as the value if a border is needed around the cells of 

the table, if not “0” is used as the value.
boardercolor Shows the colour of the boarder.
background Used to include a picture to the background of the table. File 

name or the path related to the picture is used as the value.
cellpadding Shows the gap between cell border and its content. value is 

indicated as a number of pixels.
cellspacing Shows the gap between cells. Value is indicated as a number of 

pixels.

Example :  <table border = "1"width ="400"  height ="150"     
      cellpadding = "5" cellspacing = "5" bordercolor = "green" bgcolor = "yellow">

Output

Figure 5.34
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Caption Tag 

This tag is used to include a title or a description of the table above it. Even 
if there are no attributes, this caption can be decorated using the tags related to text 
decoration. 
Example :  < Caption><b><u>Principle Forms of Land use </ u></ b></ Caption>

<tr> Tag   

This element, which is indicated as <tr>, adds a new row to the table. Just 
like in <table>, the attributes such as "align", "bgcolor", "border", "bordercolor" 
can be used differently for separate rows. 
Example :  <tr bordercolor = ''green'' bgcolor = ''yellow'' background = ''image.
png''>

<td> Tag

Used to create cells to include data in a row. Just like for rows, attributes can 
be added separately for cells as well. 
Example : <td  width = ''4'' bordercolor = ''green'' bgcolor = ''yellow'' background

       =''image.png''>
Sometimes, cells should be merged adding several rows or columns of the 

table. There are two attributes used for this.
1. Colspan - Used to create a cell merging several columns. The value of this 

attribute is the number of columns merged. 
Example :

Figure 5.35 

2. Rowspan - Used to create a cell merging several rows. The value of this attribute 
is the number of rows merged.
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Example :

<th> tag

Figure 5.36

<th> Tag

This tag, which is called the table header tag, is used to indicate the captions 
of the rows of table. However, this can be used instead of <td> tag related to any 
cell of the table. What is special about this is that the text in the cell will be bold. 
Including colspan and rowspan, all the attributes related to <td> tag can be used for 
this tag as well. 

Activity

Create a web page which includes a table as given below. Make changes 
to the table using what you have learnt so far and understand thoroughly 
various tags related to creating tables and their attributes. 

Create a website as your team has planned using a suitable HTML 
editor.
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5.2 Web Designing Software

A sound knowledge of HTML language is essential in designing websites 
using simple word processors or HTML editors. Further HTML coding takes more 
time. Moreover, the basic HTML codes need changing for updates and alterations.

But, there are other web designing software which facilitate web designing 
quicker and more attractive. There the graphical user interface provides facilities to 
designing, editing, preview and upload.  As per the concept WYSIWYG (What You 
See Is What You Get), you can create web pages in the same way you design them 
on the graphical user interface. 
There are various types of web designing software. For instance,
1. Web authoring tools
2. Content Management Systems (CMS)

5.2.1 web authoring tools

The special feature of this type of web designing software is that the relevant 
HLML document is automatically prepared in a separate interface while the 
designer is finishing the web page using a graphical user interface. If the designer 
has knowledge of HTML coding, web page designing can be done using graphical 
user interface as well as HTML document.

There are many open source web editors such as Kompozer, Ckeditor, 
Bluegriffon which can be downloaded from Internet while there are lots of web 
editors like Adobe dream viewer, Microsoft front page, Visual studio that are to be 
purchased.

Figure 5.37 - Standard symbols of some open source web editors   

Designing a website using a web editing software 

Imagine that a website of six pages is planned to design on the topic "Various 
systems of human body". Figure 5.38 shows the structure, preview and the content 
of its Home Page.



For free distribution158 For free distribution 159

Hyperlinks to other web pages Hyperlink to another website

Figure 5.38 - Home Page  

This home page contains the title, images of human systems, a short 
description, hyperlinks to the other five web pages and further details.

This website can be designed using any web designing software you prefer. 
The steps to design it using kompozer software are as follows.

Step 01 - Figure 5.39 shows the interface after installing kompozer. exe file in 
  kompozer software (E.g. - www.kompozer.net/download-07.php). 

to insert tables   

to insert pictures    

to attach files  

web page designing areato see HTML code to preview

to format letters and texts  

Figure 5.39 - Interface of Kompozer software

For more information.......

2015For the grade 11 ICT book



For free distribution158 For free distribution 159

Step 02 - Type the title “Systems in Human Body” on the topmost in web 
  designing area. Format the title by changing font, type, size, colour
  and background colour.

Step 03 -  Using commands in File Menu, save it in a suitable folder with a 
  suitable name. Preview your webpage using a web browser.

д נּ רּ וֹ : 42  Řֹו ş ס  ĭ ‌ Ī  Ćгּצ ן בּ ‏ךּ וֹםפֿ תּ ‏ ٍ ךּ � וֹ◄ד   Figure 5.40 - Dialog Box to insert a table 

Step 04 - Though the image and other  
  texts can be included as  
  given above, use of a proper  
  content layout makes the  
  task easier.
  Let us include a table for  
  this. Get the Dialog Box  
  given in Figure 5.40 using  
  “Insert Menu” or “Table tool” 
  in Menu bar.
  Insert a table with 6 raws 
  and 3 columns.
Step 05 - As in word processing, the table can be formatted to change size of 
  cells, insert, delete and merge cells. Format the table as in figure 
  5.41.

Systems of the Human Body

Figure 5.41 - Arrangement of cells in the table 
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Step 06 -  Format the table including texts, images, hyperlinks as in Figure 
  5.39. It is easier if all the images used to design web pages are saved 
  in one folder. 

Step 07 -  New pages can be opened using “New tool”. Create separate 
  pages for each system on the Home Page. Save these in the same
  folder using suitable names.

Step 08 -  After forming hyperlinks to the relevant pages, preview the web page 
  and format as necessary.

5.2.2 Static websites and dynamic websites 

There are two types of websites according to the nature of its content as 
static and dynamic.

1. Static Websites
If the content of a website is maintained without any change over a period 

of time, such a website is called a static website. Normally, websites based on 
HTML language are static websites. Their structure and content are designed using 
HTML codes. The web content can be changed only by changing the code.

This kind of websites can be designed in a very simple way as a collection 
of a number of web pages. Users are not directly connected to the web server when 
using the websites. Only the designer of the website can enter the relevant changes 
by connecting to the web server where the website is hosted. These websites are 
safer even though it consumes more time for coding.

Websites that were created so far using word processing software, HTML 
editor, web editor etc are static web sites.

2. Dynamic Websites
If the web content is often changed, such a website is called a dynamic 

website. These are designed using software such as PHP (Hypertext Preprocessor), 
ASP.net (Active Server Page.net), JSP(Java Server Page). Here the web server 
generates information using a data base or program. 
Example:

1. Current time is displayed as dynamic in a website.
2. Showing results of a candidate related to the index number.
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Users are directly connected to the web server while using such websites. 
Information is exchanged from the user to web server or vice versa. Hence, the 
security of the website is threatened compared to a static website.

This is more appropriate for commercial, social or exam holding websites 
which should be often changed. However, higher knowledge and experience are 
required to build such websites in a protective way.

Server Client/browser

Static

Web server Database server Client/browser

Dynamic

Figure 5.42 - Static and dynamic websites

5.2.3 Content Management Systems (CMS)

CMS can be defined as software used for dynamic website designing, content 
management and publishing. It is possible for the web designer to re-publish his 
website often changing its content.

Web designing and managing using CMS is very easy and fast, while 
no prior knowledge of computer languages is required. Hence, CMS is the most 
popular web designing tool at present.

The creativity of designing is limited to a certain range if various audio 
visual information is entered to the website using templates and wizards provided 
by the software. All the websites that are designed this way will be monotonous. 
This weakness can be largely avoided by changing relevant codes if you possess 
a sound knowledge of computer languages such as HTML, PHP, javascript, CSS, 
SQL. 
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Some open code CMS software with their web addresses are as follows.
1. Joomla (www.joomla.org/download.html)
2. Wordpress (www.wordpress.org/download)
3. Drupal (www.drupal.org/download)

How a website is designed using a CMS software

You can design this website using any CMS software you prefer and the 
steps to install ''Joomla'' software are as follows.

Step 01 - Install the three types of software given below in your computer. 
  The web addresses required to download these are also given.

1. APACHE (www.apache.org)
2. PHP(www.php.net)
3. MySql (www.mysql.com)

However, it is easier to install a single package which includes all the above 
two such software are as follows.

1. WAMP (www.wampserver.com)
2. XAMPP (www.apachefriends.org/index.html)

Step 02 -  Download Joomla software from www.joomla.org website and 
  install it in your computer. Since there are lots of steps here, get 
  necessary advice from a suitable website. 

  Example - https://docs.joomla.org/J3.x:Installing_Joomla

Step 03 -  There is need to select proper templates, articles and components 
  for a new website. Get necessary advice for this from a suitable
  website. 

Step 04 - See the preview and do the necessary changes to your website.

Activity

 Build the website your team planned using Joomla software.
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5.2.4 Roles related to web designing

Designing a website for a certain institute and maintaining it while keeping 
it updated is a team work involving in many people. Each person has a role to play 
with the relevant tasks and many responsibilities. Let us identify some important 
roles among those.

1. Author - Designs interfaces of the website 
2. Editor - Writes codes, checks errors and rectifies those.
3. Publisher - Fulfills tasks related to the publishing of the website.
4. Administrator - Fulfills maintenance tasks related to the web server and 

database.
5. Users - Use the website.

 5.3 Publication of a website 

Publication of a website includes the tasks such as designing website, 
hosting, updating and posting etc. There are several requirements a web publisher 
should fulfill for this. 

1. A web designing software
2. A web host
3. A domain name
4. File transfer protocol
5. Internet connection

5.3.1 Web Host

The designed website should be hosted in a place where any person 
can access at any time from any place through Internet. Such service providing 
computers are called web hosts.

If the website is designed for a mass scale institute, normally they have their 
own dedicated host. If it is for a small scale institute, they get space from shared 
hosts maintained by other institutes. Shared hosts charge basic fee and annual 
charge according to the allocated capasity. There are many institutes in Sri Lanka 
as well as in the world which provide such web host services.

There are institutes which provide web host services free of charge as well. 
You can get this facility through various websites. Here, their advertisements are 
also displayed in your website.
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Activity

Name two institutes which provide free web host services along with 
their relevant web addresses.

5.3.2 Domain Name

National identity number is given to each and every person in the world to 
identify a person uniquely.

In the same way, there is a system to find a website in the World Wide Web. 
It is known as ICANN (Internet Corporation for Assigned Names and Numbers) 
that bears the responsibility of assigning and administrating domain names for 
websites. After designing a website, it should be registered in that institute with a 
suitable domain name. Some of such other institutes are as follows.  

1. www.godaddy.com
2. www.bluehost.com
3. ww.nic.lk

It is more appropriate to get registered paying a basic fee. Registration 
should be renewed paying an annual fee. Sometimes, it is done by the person who 
is responsible for hosting. However, if you need to host your website in another 
web host later, this can create issues on registration. Hence, it is more appropriate 
if the publisher himself registers the website.
Things to consider when selecting a domain name to a website.
1. It is appropriate to give a certain identification about the institute the website 

belongs to or the objective of preparing the website through the domain name. 
This makes the users easier to find the website through search engines.  

Example: The web address www.nie.lk indicates the institute the website
belongs to the user by the domain name “nie”.

2. According to the nature of the website, top level domain names such as “.com”, 
“.edu”, “.org”,“.lk” can be attached.

Example: The top level domain name “.org” of the web address www.
wikipedia.org indicates that it belongs to non commercial type websites.

 Organizational hierarchy Geographic hierarchy

.(Root)

com edu uk fr pe sp jp cd gr ...milgov net ... ...

Figure 5.43 - Domain names of websites
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3. If the domain name is short, it is easy for the user to remember it as well as to 
type it accurately.

4. It is not appropriate to include numbers, lines, in domain name. The reason 
for this is when the web address is read orally, it may not be communicated 
correctly to the listener.

Example:

Reader Listener

www.myweb2.org www.mywebtu.org

Activity

Visit www.nic.lk and study the steps to obtain .lk domain name. 

5.3.3 File Transfer Protocol/FTP

These are the software used to transfer the website you have designed to the 
selected web host according to the international standards. These can be purchased 
or downloaded free from Internet.
Example - 1. Filezilla (https://filezilla-project.org)
  2. SmartFTP (https://www.smartftp.com)

Since most of the web designing tools include file transfer facility as well, 
another software is not needed. Further, the institutes which provide shared host 
services too provide the facility of file transferring.

5.3.4 Internet Connection

Internet connection is essential for the three steps of publishing a website 
– transferring, updating and path declaration. Internet connection is the medium 
which connects the users with the web host.

A proper Internet service provider should be selected to get Internet 
connection. Things such as the speed of the connection, charges, and maintenance 
services should be considered here.
Some Internet service providers in Sri Lanka are as follows..

1. Sri Lanka Telecom
2. Lanka Bell
3. Mobitel
4. Dialog Axiata
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5.3.5 Maintenance of Website

Regular maintenance is an essential factor for the success of a website. This 
can be explained from several aspects.
1. Depending on the nature of the website, its content should be updated daily, 

weekly or monthly. Not only should the content of the website be changed 
here, but also the way it is presented, pictures, colours, shapes and other objects 
should be changed. By maintaining a column on the Home Page to publish new 
information, current changes can be updated instantly.

2. Harmful software like viruses, unauthorized access can create the website 
malfunction. Hence, regular attention should be paid, while getting back up 
time to time and proper security methods should be followed.

3. If there are new versions of the software used to design the website, website 
should be updated accordingly. It is important for the security of the website.

Activity

Publish the website your team has designed following proper steps.

Website designing and development process can be summarized as follows;

1)  The concept

3)  Domain 
name

2) Design      
develop

4)  Hosting5)  Upload

6)  Test

7) Update and 
manage

Stages in web design 
and development 

Figure 5.44 - Steps of web design and development
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 ² In web designing, it is essential to design it with a structure and a pre design, 
and organize it well with the proper content which suits the needs of the 
users of the web site.

 ² Depending on the content, there are two types of web sites – static and 
dynamic.

 ² HTML is the basic language used for web designing. Knowledge of this 
language is essential to be a successful web editor. This makes writing 
HTML codes easier.

 ² Simple web sites can be designed even without any knowledge of HTML 
language, using the software such as web authoring tools and Content 
Management Systems.

 ² Dynamic web sites can be designed using Content Management Systems.
 ² A suitable web host, domain name, and a file transfer protocol should be 

selected to publish a designed web site.
 ² There should be a maintenance process for the success of a web site.

Summary
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   After studying this chapter, you will understand the following:
 ² Contribution of ICT to entertainment
 ² Ethical and legal issues in ICT
 ² Precautions related to ICT infrastructure protection
 ² Health and safety issues inherent in the use of ICT

  

6.1   ICT in entertainment
 Society is driven towards various forms of entertainment facilities for 
relaxation from everyday stress. However, most people prefer watching a film for 
relaxation. Unlike in the past, film producers nowadays enjoy the advantage of 
producing films of high quality with the use of ICT. Some of these modern facilities 
that film producers enjoy are as described below:

Figure 6.1 - movies created by 3D 
technology

i) 3D – three Dimensional   
  With the use of advanced technologies 

producers can now make life look real on films 
using three dimensional technology.  
To view films using 3D technology the user 
needs to use 3D spectacles available for the 
purpose. 

Figure 6.2 - Holographic image 
processing technology

ii) Holographic image processing technology 
   A scene from a set shot in some place 

is recorded on camera. Holographic image 
processing technology is used to display this 
image elsewhere. This technology is mostly 
used with scenes depicting horror.

6
Information and Communication 

Technology and Society
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Figure 6.3 - Cartoon films 

iii)   Cartoon films 

  Cartoon films are popular among both 
adults and the young. The 3D features 
and the development of technology in 
the relevant software have increased their 
attraction. (Fig 6.3)

Figure 6.4 - Digital audio materials

iv)  Digital audio materials
  The use of the computer is evident 

with modern music and related editing. 
Recording of songs, creating rhythm and 
mixing are freely done using modern 
software to entertain audiences (Fig 6.4).

  Songs recorded in this manner 
can easily be stored on compact 
discs (CDs) and other digital media.

Figure 6.5 - Home Theatre systems 

It is also possible to listen to or view 
them using home theatre systems (Fig 
6.5).

Figure 6.6 -  Digital games 

v)  Digital games
  Digital games have 

become very popular today. 
Digital games can easily 
be played on computers or 
cell phones. Digital games 
in both 3D and 4D (four 
diamentional) are the most 
popular today.
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vi)  Simulation games
  Simulation games are based on an 
everyday activity in a natural setting created 
artificially.

Simulation games are mostly used with 
training for sports activities, investigations, 
planning, military training, mercantile 
activities, and miming.

Figure 6.7 - Simulation games

6.2   Problems associated with the use of ICT

It is possible for Information Communication Technologies (ICT) to be 
mankind’s closest friend providing many facilities to make life comfortable. Yet, 
with the use of ICT, mankind faces many unforeseen problems. These problems can 
be related to the following:

Legal 
issues

Issues related 
to Values

Physical 
problems

Harmful 
software

Environmental 
issues

Health 
related 
issues

Social issues
Issues associated 
with the use of 

Information and 
Communication 

Technology

Figure 6.8 - Issues associated with the use of ICT
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These issues and likely solutions are detailed in the following sub-section.

6.2.1  Legal issues

Figure 6.9 -  Data thefts

i) Data thefts -
  Personally Identifiable Information (PII) 

stolen from a computer or other device can be 
considered as data theft.
E.g. - stealing or keeping flash drives, digital  

 camera, mobile phones that contain 
 personal names, telephone numbers,  
 photos etc. without permission or legal 

   rights.
ii) Unauthorized access into computer systems -       

  It is possible to access computer systems unlawfully with the theft of or 
manipulating user name and password of a computer.  An organization's data 
can easily be stolen in this manner.

iii)  Intellectual property rights -
1. What are intellectual property rights? 
Intellectual property usually relates to mind creations. Intellectual property 

rights relate to an innovation or a completely new product from a person or an 
organization currently. Such innovations or brand new products to enter the market 
are the property of the first person or organization to develop and release the product. 
They claim ownership to the innovation. It is their right to identify themselves as 
the legal or lawful owners.   

Presenting such products in the names of others or using such products 
for other developments or sale of such products without the knowledge of the 
first person or organization is illegal. Such claims belong to the category of stolen 
intellectual property.

2.  It is possible to obtain patent rights for protection of intellectual property.
A patent is a license issued by the State for innovations. To receive a patent 

license the innovator must apply to the national office governing patents.

iv)  Fraud 
Computer fraud is any dishonest misinterpretation of fact intended to let 

another to do or refrain from doing something which causes loss. The fraud will 
result in obtaining a benefit by, for example: 
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• Altering in an unauthorized way (e.g. employees entering false data)
• Altering, destroying, suppressing or stealing output to conceal unauthorized 

transactions
Identity theft: deliberate use of someone else's identity as a method to 

gain a financial advantage. (e.g. someone using another's Personally Identifying 
Information, NIC numbers, credit card numbers etc. without permission to commit 
fraud.

6.2.2  Issues related to values

Figure 6.10 - Plagiarism

i) Plagiarism
  Plagiarism is the act of stealing another’s 

creative work and displaying it as one’s own. 
Plagiarism is very common among users of 
computers today with the stealing of data and 
other related information from the Internet.  

  It is possible to use data and other 
information collected from the Internet in 
better accepted ways. Better accepted ways refer to the correct use of such 
collected information without in any way harming the reputation of the correct 
owner. This, can be done by, 

1. citing - mentioning the rightful owner and his/her information.
2. quoting - the use of inverted commas (“…”) to identify a selected or borrowed 

section.  
3. referencing - the listing of resources from which the information was collected.  

This is usually done at the end of an essay or article.

6.2.3  Physical and logical issues

Computers need to be used carefully. Careless use of computers is likely to 
bring about both physical and logical issues.

Sudden power failures may lead to damaged computing devices. There may 
be computer thieves. It is also possible to experience a complete network breakdown 
with malware coming through the Internet. Environmental factors also contribute 
towards physical damage to computers.  

If so, how can computers be made secure to free ourselves from physical 
and logical issues that are likely to arise?
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 ¾ Physical Security

i) Uninterrupted Power Supply (UPS) 
  In case of an electricity breakdown, there has to be some alternate 

arrangement to supply power to the computer so that the network and the 
documents face no harm. Here, the alternate arrangement to supply comes 
with the battery contained in a UPS. This prevents interruption to the supply of 
power to the computer.(Fig. 6.11).

Figure 6.11 - Uninterrupted Power Supply (UPS)

Computer

UPS
Main Supply

ii) Hardware Firewalls
  Hardware firewalls bought as a separate unit have now been built into 

broadband routers. Hardware firewalls are essential especially with computer 
networks connected to the Internet. A firewall protects a network from 
unauthorized access to or from a network by filtering data that pass through it. 
All messages entering or leaving a network pass through the firewall, which 
examines each message and blocks those that do not security criteria (fig. 6.12)

Figure 6.12 - Hardware Firewalls

Outgoing 
Data

Incoming 
Data

Firewall

Internet
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Figure 6.13 - Controlled 
access through doors

iii) Controlled access through locked doors  
Closed and locked doors are essential to ensure 

security of a computer laboratory. Closed and locked 
doors prevent or limit unlawful entry of people. It can also 
improve safety of computer systems and other accessories 
while protecting the information contained (Fig 6.13).

Figure 6.14 - CCTV 

iv) CCTV
  It is possible to install CCTV cameras inside a 

computer laboratory and monitor movement from 
outside or arrange for the day’s proceedings to be 
recorded as a video clip for viewing later (Fig. 6.14).

   

v) Surge protector
  The surge protector 

protects computers and other 
accessories inside a laboratory  
by controlling the voltage in 
the power supply. The local 
voltage supply for houses or 
offices is 230 V. The surge 
protector acts in situations 
where the power supply 
exceeds this limit, to control 
the destruction  that could 
happen to electronic devices 
(Fig 6.15).

 Figure 6.16 - Environmental factors

vi) Environmental factors
Environmental factors can affect the 

proper function of a computer. Therefore, 
it is important to maintain a laboratory or 
a private computer in a safe environment 
free from dirt, dust, moisture and the like 
(Fig 6.16).

Figure 6.15 - Surge protector
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 ¾ Logical Security

Figure 6.17 - Passwords 

i)  Passwords
  Passwords are used to secure data 

stored in a computer. Passwords protect 
unauthorized entry or use of a computer. 
In using a password, it is advisable to mix 
letters, symbols and numbers to make the 
password stronger. (Fig. 6.17)

 Figure 6.18 - Software Firewalls

ii) Software Firewalls 
Software firewalls are installed on a 
computer (like any software) and can 
be customized by the user. A software 
firewall will protect a computer from 
outside attempts to control or gain access 
to it (Fig. 6.18).

Figure 6.19 - Backups

iii) Backups
  In the event of a failure of a computer 

system, essential data and information 
in the computer can be lost. Therefore, 
a backup is essential towards securing 
protection of data and information. A 
backup can be maintained in an external 
hard disk, CD, DVD, a flash drive or a 
memory chip. It is also advisable to keep 
such backups securely in another physical 
location. (Fig 6.19)
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6.2.4 Malicious software / Malware  

Figure 6.20 - Malicious 
software 

i) The use of a computer involves various threats. 
Malicious software/Malware or malicious codes 
cause serious harm to computers and networks in 
many ways. Some examples of such effects are 
listed below:

 ² Decreased efficiency of the computer. (Improper 
function, unnecessary attempts or re-start again and 
again)

 ² Destruction or mal-function of software 
 ² Inability to install other software
 ² Weaken computer hardware
 ² Sabotage of computer networks
 ² Data theft and destruction  
 ² Reduction of the storage capacity of the hard disk by storing unnecessary 

documents and files.

Harmful software and resultant damage

A few types of harmful software and resultant damage are as described in the Table.

Harmful software Resultant damage
Computer Virus Computer viruses gain entry into the computer through 

a computer program and spread rapidly within the 
computer causing enough harm. Viruses can enter a 
computer through networks, a USB flash drive, external 
devices like memory chips, or through e-mail. Viruses 
enter the system as executable files. In other words the 
viruses always remain active within the computer.  

Computer Worms Computer worms also act similar to computer viruses.  
Worms, however, are capable of acting and spreading 
alone using e-mail attachments, false websites and 
instant messages. 



For free distribution176 For free distribution 177

Spyware Trojan Horse
The Trojan Horse is a harmful software based on the 
Greek Trojan Horse constructed using wood. It presents 
itself as harmless and enters the system without the 
knowledge of the user. Trojan Horse spyware makes 
the user uncomfortable by unnecessary opening up 
windows, producing different desktops, deleting 
documents and stealing data. Further, it allows other 
harmful software to gain entry. Trojan  enters computer 
with e mail attachments. However, unlike computer 
viruses and worms, the Trojan Horse does not spread 
by itself.   
Adware
The adware is displaying unnecessary notices on the 
computer screen. Using these advertisements, adware 
collects commercial information. Adware is not harmful 
as other computer viruses but disturbs the user mentally.

Bots Bots are derived from the word ‘robots’. Bots is harmful 
software that functions on its own communicating 
with other networks. Bots are used to collect 
personal information through Internet messages and 
conversations.  

Hijacker/ Browser 
Hijacker

Hijacker/Browser Hijacker is capable of misdirecting 
a user to a different website through the Internet, to 
collect information regarding trade, commerce and 
advertisements. Hijacker, is similar to adware.  

Phishing Phishing is the art of deceiving users to collect 
information about bank accounts or electronic accounts.  
E-mail is used for the purpose.  Such mail is sent through 
a popular organization or a friend together with a link 
for access. With a click on the link, or by filling forms, 
valuable information and cash deposits related to the 
unsuspecting user get stolen.        

Spam Spam is unauthorized e-mail. Most often, spam relates 
to advertisements about products or a mail from an 
unknown person. The mail box can get filled with such 
mail and make the user uncomfortable. Also, Spam may 
collect e-mail addresses that can be used unlawfully for 
frauds.  
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Safeguarding computer and a computer network from harmful software

 ² Install a virus guard into the computer. Update the virus guard as is 
necessary. Keep Guard/Shield/Auto Scan/Update always active.

 ² Be careful with the use of a USB memory.  Check USBs for possible viruses 
using anti virus software.

 ² Always install authorized software
 ² Instead of an administrator account, maintain a user account

If the computer is connected to the Internet, 

 ² Access secure websites. Check URL for verification.
 ² Select only secure websites for the download of software or other material.
 ² Before a download, check with a virus guard.
 ² Be careful with opening up e-mail. Where necessary use a virus guard 

before a downloading and attachment. Do not click on suspicious links in 
e-mail. Avoid opening suspicious e mails.

 ² Avoid suspicious advertisements or messages.  
 ² Do not enter personal information without checking on security.
 ² Use firewall, virus guards, email filters to avoid the risk.

Some secure, popular virus guards to be installed on a computer are as follows.

 ² Avira Antivirus
 ² Avast Antivirus AVG Antivirus
 ² K7 Antivirus
 ² Digital Defender Antivirus
 ² Norman Antivirus
 ² Kaspersky Antivirus
 ² Panda Cloud Antivirus (B)
 ² Microsoft Security Essentials
 ² Norton Antivirus
 ² BitDefender Antivirus
 ² McAfee Antivirus

Prevention is better than cure 



For free distribution178 For free distribution 179

 Make a list of virus guards from the Internet other than what is 
mentioned above. Tabulate the names of the manufacturer and the 
dates of manufacture.

Activity

Agencies in Sri Lanka responsible for the security of information exchange

  There is hardly any individual or an organization in Sri Lanka who/which 
is not connected to the Internet. Over the last few years, unauthorized access into 
social networks, financial websites has been observed over the world. Sri Lanka is 
no exception. Therefore, the necessity for responsible agencies to secure Internet 
access has arisen. This is also called ‘Cyber Security’. 
  Cyber security is not limited to e-mail, Internet solutions, or social 
networks. They are useful for personal networks and operating systems (OS). Some 
organizations responsible for cyber security are as follows.
 ² Institution for Information Security of Sri Lanka

Information and Communication Technology Agency (ICTA) is responsible 
for the establishment of this institution in Sri Lanka.  It provides facilities to various 
organizations as listed below:

 ◦ Citizens
 ◦ Business establishments
 ◦ State institutions.

² ICTA, Sri Lanka Standards Bureau and the Sri Lanka Emergency 
Computer Services have together organized to certify Information Security 
Management Systems (ISMS) to ensure security of  information. Individuals 
and organizations can register for this.

 Access the websites given. Make a list of computer related services 
you can obtain from them.

http://www.gov.lk/web/
    http://www.engage.icta.lk

      https://www.techcert.lk/si/
 https://www.cert.gov.lk

Activity
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6.2.5  Health issues related to use of Information Communication 
    Technology

 ² Ergonomics and health issues

Ergonomics is a word made with the use of two words in the Greek 
Language. According to Greek Language “ergon” is job or action. “nomos” is  law. 
Therefore, the simple meaning to be collected from this word is:

“a job must be created to the comfort of the worker and the worker must not 
be forced to adjust himself/herself to the work. If not, the worker will subject 
himself/ herself to various tensions and illnesses.” 

As of today, technology has become indispensable to mankind. Technology 
and mankind are now interconnected as inseparable. Daily, the numbers using 
technology keep increasing. As a result, technology related health issues too keep 
increasing. Issues arise as a result of the continuous use of a computer for over four 
hours at a stretch.  Let us take a look at these health issues:

Figure 6.21 - Musculoskeletal 
problems

i)   Musculoskeletal Problems
  Non-stop use of a computer can bring about 

pain in different muscles and bones of the human 
system. The main reason for this is the wrong 
posture taken with the use of the computer (Fig 
6.21).

Figure 6.22 - Repetitive Stress 
Injury

ii)  RSI – Repetitive Stress Injury
  Repetitive stress injury is the pain extending 

from the shoulder to the fingers of the body.  The 
affected areas can show swelling and hardness 
that brings out the pain. The difficulty to move 
the mouse is a result of this pain. The cause of 
the pain is incorrect posture (Fig. 6.22).
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Figure 6.23 - Carpel 
Tunnel Syndrome

iii)  CTS – Carpel Tunnel Syndrome   (Fig.6.23)
       Carpel tunnel syndrome is the feeling of 

a numbness and pain in the fingers. The pain 
arises due to the pressure exerted on the wrist.  
Incorrect use of the key board and the mouse 
or placing them in the incorrect positions are 
reasons for the syndrome.

Figure 6.24 - Computer Vision 
Syndrome

iv)  CVS - Computer Vision Syndrome • 
      Sticking to the computer continuously 
for 6 to 7 hours can cause irritation of the 
eyes and is identified as the Computer Vision 
Syndrome.  Dry eyes, redness in the eyes, 
tearing, blurred vision, or pain in the head, 
neck or back are symptoms of the discomfort. 
(Fig.6.24)

Figure 6.25 - Headache

v) Headache
    Pressure on the muscles of the neck 

and tiredness around the eyes usually cause 
headaches to users of computers. (Fig. 6.25)

Figure 6.26 - Stress

vi)  Stress
    Increase of activities in the working 

environment due to the technological 
advancement cause stress, sleeplessness, 
tiredness, lack of appetite etc. (Fig. 6.26)
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How can these health problems be avoided?

Correct posture in the use of a computer, is essential. This is an essential 
feature of ergonomics.

Correct posture in the use of a computer can help prevent many problems 
associated with health. They are,

Figure 6.27 -  Correct posture
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1. Keeping the computer on a suitable table at eye level or a little lower.
2. The distance between the computer screen and the eye to be 18 – 28 inches 

or 45 – 70 cm.
3. Keeping the user’s back straight against the back of the chair and keeping 

shoulders relaxed.
4. Keeping legs vertical to the ground with the soles flat on the surface.
5. Keeping the mouse near the computer, keying in words lightly, moving wrist 

as is necessary while keeping the keyboard straight at elbow level or lower.

To adhere to these movements:
  

 ² Adjust light on the computer to make the eyes comfortable
 ² Blink and take eyes off the screen on and off
 ² Take a break in between work, walk short distances
 ² Fix playtime sessions for children and direct them to other activities
 ² People using computers at work for 7 to 8 hours need to refrain from using 

computers at home and maintain a relaxed mind.

Followers of these procedures are unlikely to face health issues.
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6.2.6  e waste - Harmful elements and effects on environment  

Electronic products such as computers, television, mobile phones, printers 
worked using electricity or powered by batteries have become non working after 
reaching the end of their useful life are known as e waste. ^Figure 6.28&

Personal electronic 
devices

Audio/video 
equipment

e waste

Mobile 
phones CFL bulbs

Television

Scanners 
and copiers

Mouse, key 
board and other 

electronic devices

Figure 6.28 - e waste at the end of the useful life

These productions are made up of lots of harmful elements. Once the useful 
life is over and discarded to the open environment without following the correct 
procedure of disposal, it causes immense harm to humans and the environment as 
well. Pollution of the environment effects man himself.  

Liver

Skin
Lungs
Brain

Figure 6.29

If CFL (compact fluorescent light) bulbs are disposed in an improper way, 
it can harm the environment since they contain minute particles of mercury, a toxic 
metal that is hazardous.
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Health hazards and effects of Mercury
 ² Damage to brain cells
 ² Disruption of the nervous system
 ² Allergies on the skin
 ² Once inhaled, Mercury vapour can harm kidney, liver and central nervous 

system 
 ² Damage to DNA (Deoxyribonucleic Acid) and chromosome 

Further, the improper disposal of other e waste can cause swelling and 
irritation on the body, nausea, stress, issues in blood veins and cancers.
some such harmful elements are, 
Arsenic, Barium, Beryllium, Cadmium, Chromium, Dioxins, Lead, Mercury, 
Selenium

Proper disposal of e waste

1. Reduce usage - Reduce unnecessary purchase by maintaining the existing 
electronic devices

2. Reuse - Sell or donate old but working electronic devices without discarding
3. Recycle - Directing irreparable devices to an institute which recycle them

1. Visit the website of Central Environmental Authority of Sri Lanka 
and identify the steps that are taken for e waste disposal.

2. Visit www.ewaste.lk, the institute dedicated to the proper disposal 
of e waste in Sri Lanka. Prepare a booklet containing the services 
provided by that institute and how these services are obtained.

Activity 

6.2.7  Social issues related with ICT

Figure 6.30 - Digital divide 

Hey, Mr. Jhonson..
Mr. Jhonson?

i) Digital divide 
  Digital divide is an economic and 

social inequality due to the differences in 
access to, ability to or use of Information 
Communication Technology.
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Some of the reasons for the digital divide are as follows;

 ² Education 
 ² Ability to use technology 
 ² Affluence
 ² Industrial development  
 ² Suburban

 ² Lack of education 
 ² Inability to use technology
 ² Poverty
 ² Under industrial development
 ² Rural

Figure 6.31

 ² Education/Lack of education - Ignorance regarding the benefits of 
Information Communication Technology  and their use create differences 
among individuals.

 ² Availability/Unavailability of technical know-how - There is little possibility  
of connection between people who are knowledgeable of and make good use of  
Information Communication technology with those who are totally ignorant of 
Information Communication Technology or their uses.

 ² Affluence/Poverty - Even though, there is a need and the necessity to learn and 
use ICT, afford ability becomes a matter for denied.

 ² Industrial development/under industrial development - Industrialization of 
a country is a reason for the use of Information Communication Technology. 
Non-industrialization leads to a digital divide between countries.

 ² Suburban/Rural - Those leading urban lives are very busy and use Information 
Communication Technology heavily. On the other hand, those leading simple 
lives freely in rural areas simply do not care for the use of Information 
Communication Technology. As a result, there arises a digital divide between 
people.

ii) Digital Bridge -  Digital bridge is forming connections among people avoiding 
the digital divide. However, it is not possible to create a digital bridge by 
providing each and everyone with a computer or a mobile phone.  It is necessary 
for people to acquire different technological products, get to know them and 
learn how to use them effectively. Otherwise, the technology may become 
meaningless and lose value.  
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How to form a digital bridge

Figure 6.32 - Digital Bridge

 ² Digital Literacy – Acquiring ICT Knowledge helps get over a digital divide. 
Establishing places such as, Vidatha centres, Nenasala centres, Computer 
Resource Centers to provide free use of computers or at low cost in different 
parts of the country, can contribute towards overcoming a digital divide. To 
promote the use of such centres, there need to be mobile publicity, delivery of 
handouts and poster displays.  

The benefits of digital literacy are as follows:
 ◦ Realization of the need of using ICT resulting in an urge to use it
 ◦ Helps overcome issues arising from the use of ICT as far as possible.
 ◦ Realizes the value of using the Internet for payment of bills, doing research 

and collecting information about education, being aware of information 
related to modern medicine and in applying for jobs. 

 ² Supply of computers - Digital literacy is the foundation of the digital bridge.  
Organizing the purchase of computers at easy concessionary rates can increase 
the literacy rate in a country. It helps not only those anxious to gain digital 
literacy but also other members of such families as well.

 ² Equal opportunities to dispel other financial difficulties - Making it possible 
for everyone to access the Internet for free on a reasonable payment and clearing 
all obstacles towards this process. Easy access to the Internet for everybody will 
certainly help school children of all ages to collect necessary information for 
their study purposes while making online education possible. It will also provide 
opportunities for employment, observe market trends, exchange information 
through social networks and related concerns.
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 ² Participation of intermediaries - To make the digital bridge a success, it is 
extremely necessary to get the support of various business concerns, people’s 
associations and both public and private sector sponsorship and assistance. 

 Find what measures the Sri Lankan government has taken to get 
over the digital divide and establish a digital bridge.

Activity

iii) De-Skilling

Figure 6.33

 

De-skilling is also one of the effects of using ICT. (Fig. 7.33) Machinery or 
automation has taken over skilled labour in places of work, driving people away 
towards unemployment. It is easy to direct and maintain machinery at work. 
However, the chances lost by skilled workers are enormous and have made them 
helpless.  

People and organizations have a wealth of knowledge collected over 
the years. All this knowledge is wasted with the shift to machinery. Further, the 
change does not allow for more knowledge and allows for lost opportunities. These 
contribute  to the disadvantages of automation. 

A few such examples are discussed below:

 ² Machinery has taken over the industry replacing the talents of people.
 ² Libraries have been made to close down and jobs in the sector lost due to 

the electronic books and magazines.
 ² Online learning through the distance mode has limited teacher resources.
 ² Health concerns are easily sorted out from home itself, cutting down the job 

opportunities in laboratory services
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Technology related employment opportunities

Figure 6.34 - Technology related 
          employment opportunities. 

We learnt that technology would, 
in various ways deny us opportunities for 
employment. (Fig. 15.34) Yet, technology 
has, today, come to be an invaluable asset 
to mankind. The main reason for this is the 
availability of sufficient opportunities for 
employment to those aware of ICT

Some high level, prosperous and well 
paid employment opportunities for those with 
knowledge of and the ability to handle ICT 
are listed as follows. There are many more 
opportunities other than for those listed.

 ² Computer programmer
 ² Computer/Information Systems Analyst
 ² Data Communications Analyst
 ² Database Programmers and Analyst
 ² Desktop/Applications Support Specialist
 ² Mobile Application Developer
 ² Network and Systems Security Specialist
 ² Network Managers and Administrator
 ² Software Engineer
 ² Technical Sales Specialists
 ² Technical Trainer
 ² Telecom manager 
 ² Telecommunications Line Installer
 ² Website Developers

But of these, Software Engineers are the most in demand, locally and 
globally. At present, Software Engineers employed abroad have come to be the 
largest contributors towards foreign exchange earnings. This is due to the Software 
Engineers being a highly paid employment opportunity. Therefore, being highly 
educated about the development of software as well as ICT can certainly help you 
win prosperity with highly paid employment opportunities.
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6.2.8  Misuse of ICT to harm Society

i)  Social Media

Figure 6.35 -  Social Media

Social media could be introduced as 
a fertile breeding ground towards connecting 
people globally, cultivating associations 
and grouping like-minded people towards 
exchanging personal information and opinions 
on related topics of interest. Given below are a 
few services social media provide.

 ² Promote one’s products profitably
 ² Blogs – Blogs are a shortened term for Web logs and refer to routing personal 

diaries or magazines. These web logs are created for people to present their 
daily experiences or about happenings that could cause harm to society. On 
reading web logs others too can contribute opinions.

 ² Social media helps attract people using the Internet to one’s own website, 
product detailing websites or blogs.

 ² Forum – Forums are routine discussion panels. Forum provides a good 
opportunity for people to openly express common opinion.  Forum is another 
service from social media.

 ² It has become increasingly possible for social media to connect people from 
different parts of the globe share opinions, participate in lively discussions, 
exchange images, video clips, and songs.

ii) Cyber crime
However, irresponsible use of social media has engendered misconduct in 

society. This irresponsible use is identified as cyber crime. A few such acts are as 
described.

 ² Uploading others’ images without permission
 ² Releasing unsuitable photographs or videos of  women or young girls to the 

Internet and making use of such images or videos to frighten, threaten or 
blackmail

 ² Giving publicity to information that can harm a person’s reputation
 ² Misleading people with wrong information and images about others published 

on the Internet  to cause personal discomfort 
 ² Using social media to give out false information and, thereby attract others to 

finally destroy lives 
 ² Using unfair means to gain access to others’ personal accounts and stealing 

personal information. 
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iii) How can we protect ourselves from using social media?

 ² Be careful in selecting social media over the Internet
 ² Be cautious about making friends through social media over the Internet
 ² Be careful in presenting personal information to social media over the Internet
 ² Avoid accessing suspicious e-mails
 ² Do not click on suspicious links that come through e-mail
 ² Ignore anonymous e-mails
 ² Do not allow social media to access the e-mail address book
 ² Do not use personal e-mail to access social media
 ² Avoid installing applications in your computer that come through social media.
 ² Think twice before using social media 
 ² Make little children and friends aware about the harm social media can cause.

 ² Technology is used in various ways to entertain.
 ² The use of the Internet brings up issues. They relate to legal, ethical and 

physical issues, harmful software, environmental, health and the social.
 ² Patent rights help secure legal rights of intellectual property.
 ² To avoid physical issues interrupted power supply, hardware firewalls, closed 

circuit TVs restricted entry through locked doors, surge protectors can be used.
 ² Logical issues are best met with passwords, making firewalls active and 

maintaining backups.
 ² Harmful software can come in as computer viruses, computer worms, spyware, 

bots, hijackers, phishing and spam.
 ² It is safe to use antivirus software for protection against harmful software. 
 ² Physical strain can be minimized with correct posture.
 ² Electronic waste needs to be disposed of correctly to avoid unnecessary harm 

to the environment.
 ² Digital divide is a social issue arising from ICT.
 ² Digital bridge can help avoid digital divide.
 ² ICT contributes towards elimination of inherent talent.
 ² Those quite knowledgeable about ICT have an advantage over others in well 

paid employment.
 ² Safe use of social media can help minimize cyber crime

Summary


